GT Works2 Version2/GT Designer2 Version2

Operating Manual

Startup:Introductory Manual
(For GOT900 Series)
SAFETY PRECAUTIONS

(Be sure to read these instructions before using the product.)

Before using this product, read this manual and the relevant manuals introduced in this manual carefully and handle the product correctly with full attention to safety.

Note that these precautions apply only to this product.

In this manual, the safety instructions are ranked as "DANGER" and "CAUTION".

DANGER
Indicates that incorrect handling may cause hazardous conditions, resulting in death or severe injury.

CAUTION
Indicates that incorrect handling may cause hazardous conditions, resulting in minor or moderate injury or property damage.

Note that failure to observe the CAUTION level instructions may also lead to serious results according to the circumstances.

Be sure to observe the instructions of both levels to ensure personal safety.

Please keep this manual in accessible place and be sure to forward it to the end user.

[DESIGN PRECAUTIONS]

DANGER

- Output may remain ON or OFF due to failure of the GOT, communication board or cable.
  For the output signals that may cause a serious accident, create an external fail safe circuit.
  Faulty output or malfunctions may result in an accident.

- When a communication error (including cable disconnection) occurs during monitoring by GOT, communication between GOT and PLC will be interrupted and GOT operation will be disabled.
  In the case of bus connection: CPU goes down and GOT is disabled.
  In the system configuration including a GOT, an external circuit that controls the critical operation of the system such as an emergency stop switch needs to be included in case a communication failure with the GOT occurs.
  Faulty output or malfunctions may result in an accident.

CAUTION

- Do not install the control or communication cables together with the main circuit or power cable or do not bring them close to each other. The distance of 100mm (3.9inch) or more should be ensured.
  Failure to do so may cause malfunctions due to noise.
## INSTALLATION PRECAUTIONS

<table>
<thead>
<tr>
<th>DANGER</th>
</tr>
</thead>
<tbody>
<tr>
<td>* Be sure to shut off all phases of the external power supply before installing or removing GOT to/from the panel. Failure to do so may cause failure or malfunctions of the module.</td>
</tr>
<tr>
<td>* Be sure to shut off all phases of the external power supply before installing or removing the communication board to/from GOT. Failure to do so may cause failure or malfunctions of the module.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>* Use the GOT in the environment specified in the user’s manual of the GOT. Failure to do so may cause electric shock, fire, malfunctions or product deterioration or damage.</td>
</tr>
<tr>
<td>* Tighten the mounting screws within the specified torque range when installing the GOT to the panel. Loose tightening may cause a fall, short circuits or malfunctions. Overtightening may damage the screws and/or the module, resulting in a fall of the module, short circuits or malfunctions.</td>
</tr>
<tr>
<td>* Tighten the mounting screws within the specified torque range when installing the communication board to the GOT. Loose tightening may cause a fall, failure or malfunctions. Overtightening may damage the screws and/or the module, resulting in a fall of the module, failure or malfunctions.</td>
</tr>
</tbody>
</table>

## WIRING PRECAUTIONS

<table>
<thead>
<tr>
<th>DANGER</th>
</tr>
</thead>
<tbody>
<tr>
<td>* Be sure to shut off all phases of the external power supply before wiring. Failure to do so may cause electric shock, product damage or malfunctions.</td>
</tr>
</tbody>
</table>
### CAUTION

- Always ground the FG, LG and protective ground terminals of the GOT power supply area to the protective ground conductor. Failure to do so may cause electric shock or malfunctions.
- Confirm the rated voltage and terminal layout and connect the GOT to the power module correctly. Connecting to a power supply with incorrect rated voltage or faulty wiring may cause a fire or failure.
- Tighten the terminal screws of the GOT power supply area within the specified torque range. Loose tightening may cause short circuits or malfunctions. Overtightening may damage the screws and/or the module, resulting in short circuits or malfunctions.
- Be careful not to let foreign matter such as dust or wire chips get inside the module. This may cause a fire, failure or malfunctions.
- For the bus connection cable, insert it to the connector of the module until a click sound can be heard. Make sure of proper connection after installation. Improper connection may cause malfunctions.
- For the communication cable, install it to the connector of the module and tighten the mounting screws or terminal screws within the specified range. Loose tightening may cause short circuits or malfunctions. Overtightening may damage the screws and/or the module, resulting in short circuits or malfunctions.

### TESTING PRECAUTIONS

### DANGER

- When testing the operation of the user-created monitor screen (e.g. bit device ON/OFF or change of the word device current value, the timer/counter current or set value, the buffer memory current value), thoroughly read the relevant manual to fully understand the operating procedures. In the test operation, never change the data of the device which operation is critical to the system. Doing so may cause an accident due to faulty output or malfunctions.
## [START-UP/MAINTENANCE PRECAUTIONS]

### DANGER

- Do not touch any terminal while the module is energized. Doing so may cause electric shock or malfunctions.
- Be sure to shut off all phases of the external power supply before cleaning or retightening the terminal screws. Failure to do so may cause failure or malfunctions of the module. Loose tightening may cause short circuits or malfunctions. Overtightening may damage the screws and/or the module, resulting in short circuits or malfunctions.

### CAUTION

- Do not disassemble or remodel the module. Doing so may result in failure, malfunction, personal injury or a fire.
- Do not directly touch a conducting part or electronic parts of the module. Doing so may cause malfunctions or failure of the module.
- Be sure to secure communication cables and power cables connected to the module by ducts or clamps. Failure to do so may cause damage of the module or the cables due to accidental pull of dangling cables, or malfunctions due to poor cable connection.
- Do not hold the communication cable part by hand when pulling it out from the module. Pulling the cable connected to the module may cause damage to the module or cable, or malfunctions due to poor cable connection.
- Always make sure to touch the grounded metal to discharge the electricity charged in the body, etc., before touching the module. Failure to do so may cause a failure or malfunctions of the module.

## [DISPOSAL PRECAUTIONS]

### CAUTION

- When disposing the product, treat it as an industrial waste.
CAUTIONS FOR USING THIS SOFTWARE

1. Required PC memory
   The processing may be terminated by Windows® on a personal computer of which main memory capacity is less than 64M bytes. Make sure to secure the capacity of 64 M bytes or more.

2. Free capacity of hard disk (virtual memory)
   At least 100M bytes of free capacity of virtual memory should be secured within hard disk to run this software. The processing may be terminated by Windows® if 100M bytes or more of free space cannot be secured within hard disk while running GT Designer2. Secure enough free capacity of virtual memory within hard disk space in order to run the software. When enough free capacity cannot be secured, make sure to save projects frequently.

3. Error messages displayed while starting and editing
   "Operation will be terminated because of insufficient memory. Would you like to stop?"
   If the above message appears, close other running application software or reboot Windows® in order to secure at least 50M bytes of free hard disk space.

4. GT Designer2 and GOT display
   (a) Cautions for displaying straight line other than full line (dotted line, for example) in Bold.
      When straight line other than full line is drawn in bold, the line may not be displayed with its actual line width on a personal computer. However, it will be displayed correctly on GOT. This phenomenon does not mean data problem.
   (b) Display of end points of straight line/line freeform/polygon
      As shown below, the end points of straight line/line freeform/polygon are displayed differently between GT Designer2 and GOT.

   On GT Designer 2
   On GOT

   (c) Start position for filling patterns
      Some filling patterns may be differently displayed. For example, the start position may be different between GT Designer2 and GOT.
   (d) Drawing of different type lines
      The length of the dots varies in different dotted lines (for example: the chain lines).
   (e) Display of object
      The display position of the memory data display in graph function is different between GT Designer2 and GOT.
      Even if the display-start-line of a comment has been set, the comment will be displayed from the first line on GT Designer2.
   (f) Display magnification
      When display magnification is changed, the connected lines or figures may be separated or the filled-paint may be out of outline of the figure. However, if they are displayed correctly on the preview screen, they will appear correctly on GOT as well.
      (Example): When filled-paint is out of the outline.
5. Restrictions when the color setting is changed to the setting of less colors in the system environment (256 colors → 2 colors)
The color palette for setting color will be changed according to the updated settings.
The color on the drawing screen will be kept the same as prior to the change.
If the color setting for a [red] rectangle-figure is changed to the 2 colors (B/W), the [red] color will remain.
The colors of the image data (for example: BMP files) will be reduced when the project is saved.

6. Object function and device type
The object (bit lamp or word lamp), for which bit device setting and word device setting are separated, cannot be converted between bit device and word device.

7. When device type is changed
Confirm the device type when the set bit device is changed from bit device into word device.
The device flag may be represented as “??”, depending on the settings.
(Example) D0. b0 → D0 D0.b5 → ??

8. OS setting
Set the font size as "Small Font" when setting OS (Windows®) screen.
The GT Designer2 dialog box cannot be displayed correctly if the font size is set as "Large font".

9. When the toolbar icon appears in smaller size after startup of GT Designer2
The toolbar icon may appear in smaller size right after GT Designer2 is started up.
To correctly display the icon, initialize it as instructed below.
(Click on [Project] → [References] from the menu, and select the toolbar tab. Click on [Reset All] button in that tab.)

10. When using GT Designer2 in the PC in which the OS other than Japanese version
The text may not be displayed correctly depending on the OS versions; some version include the fonts incompatible with GT Designer2 or GOT.

11. When using Microsoft® Narrator
GT Designer2 cannot be used with Microsoft® Narrator.
When using GT Designer2, do not use Microsoft® Narrator.
**REVISIONS**

* The manual number is given on the left bottom of the back cover.

<table>
<thead>
<tr>
<th>Print Date</th>
<th>Manual Number</th>
<th>Revision</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mar., 2005</td>
<td>SH (NA)-080520ENG-B</td>
<td>Partial corrections How to Use This Manual, Section 1.1, Section 2.1, Section 2.2, Section 3.1, Section 3.2, Section 4.1, Section 4.2, Section 4.2.2, Section 4.4, Section 7.2, Section 8.3</td>
</tr>
<tr>
<td>Oct., 2005</td>
<td>SH (NA)-080520ENG-C</td>
<td>Partial corrections Section 2.2, Section 4.2, Section 5.3, Section 7.2.2, Section 7.2.3, Section 7.4.1, Section 7.4.2, Section 7.4.3, Section 7.4.4, Section 7.4.5, Section 7.4.6, Section 7.6, Section 8.1.2 Change of Section 7.1 to 7.2 Change of Section 7.2 to 7.1 Change of Section 7.2.1 to 7.1.1</td>
</tr>
<tr>
<td>Jan., 2006</td>
<td>SH (NA)-080520ENG-D</td>
<td>Partial corrections Section 4.1, Section 4.2 Partial additions Section 2.1</td>
</tr>
<tr>
<td>Jun., 2006</td>
<td>SH (NA)-080520ENG-E</td>
<td>Partial corrections Section 2.1, Section 3.2, Section 7.2.1</td>
</tr>
<tr>
<td>Nov., 2006</td>
<td>SH (NA)-080520ENG-F</td>
<td>Partial corrections Section 2.1, Section 4.2, Section 7.2</td>
</tr>
<tr>
<td>Dec., 2006</td>
<td>SH (NA)-080520ENG-G</td>
<td>Partial corrections Section 2.1, Section 4.2.1</td>
</tr>
<tr>
<td>Aug., 2007</td>
<td>SH (NA)-080520ENG-H</td>
<td>Partial corrections Section 3.1, 7.21, 8.3</td>
</tr>
<tr>
<td>Dec., 2007</td>
<td>SH (NA)-080520ENG-I</td>
<td>Partial corrections Section 2.1, 3.1, 3.2, 4.2.1, 4.2.2, 4.3, 4.4, 7.4.1</td>
</tr>
<tr>
<td>Jun., 2008</td>
<td>SH (NA)-080520ENG-J</td>
<td>Partial corrections Sections 2.1, 3.2, 4.2, 4.2.1, 4.2.2, 4.4, 5.3</td>
</tr>
<tr>
<td>Oct., 2008</td>
<td>SH (NA)-080520ENG-K</td>
<td>Partial corrections Sections 2.1, 3.1, 4.1, 4.2, 5.1, 5.3, 7.4, 7.6</td>
</tr>
</tbody>
</table>

Japanese Manual Version SH-080513-N

This manual confers no industrial property rights or any other kind, nor does it confer any patent licenses. Mitsubishi Electric Corporation cannot be held responsible for any problems involving industrial property rights which may occur as a result of using the contents noted in this manual.

© 2004 MITSUBISHI ELECTRIC CORPORATION
SOFTWARE USER REGISTRATION

After agreeing to the terms of the Software License Agreement included in the package, please access the MELFANSweb Home Page (http://www.MitsubishiElectric.co.jp/melfansweb) and make a software user registration. (User registration is free of charge.)

(1) Software Registration
You can make a software registration by accessing the MELFANSweb Home Page or faxing or mailing the "Software Registration Card" packed with the product.
After you have made a software registration, we will register the user and send the "Software registration confirmation" together with the user ID.
We will also provide the latest information, such as the new product release, version upgrade information and event information, by direct mail.

(2) Notes on Contact
Please ask questions concretely and clearly using terms listed in the manual.
When requesting us to solve a problem, provide us with detailed information for reproducing the problem.
In addition, contact the respective manufacturers when asking questions about the operating system (OS) or the other vendor's software products.
User registration is valid only in Japan.
INTRODUCTION

Thank you for choosing Mitsubishi Graphic Operation Terminal (Mitsubishi GOT). Read this manual and make sure you understand the functions and performance of the GOT thoroughly in advance to ensure correct use.

CONTENTS

SAFETY PRECAUTIONS .................................................................................................................................A - 1
Cautions for using this software ..................................................................................................................A - 5
REVISIONS .....................................................................................................................................................A - 7
SOFTWARE USER REGISTRATION .............................................................................................................A - 8
INTRODUCTION .............................................................................................................................................A - 9
CONTENTS .....................................................................................................................................................A - 9
Function Quick Reference .........................................................................................................................A - 11
Manuals...........................................................................................................................................................A - 19
ABBREVIATIONS AND GENERIC TERMS IN THIS MANUAL .................................................................A - 20
How to Use This Manual ..........................................................................................................................A - 23
Product List ..................................................................................................................................................A - 24

1. OVERVIEW .................................................................1 - 1 to 1 - 2
   1.1 When Conventional Software Is Used ......................................................................................... 1 - 1
   1.2 About Manuals .............................................................................................................................. 1 - 2

2. SOFTWARE PACKAGE CONFIGURATION ....2 - 1 to 2 - 3
   2.1 Software ........................................................................................................................................2 - 1
   2.2 Other Included Data ....................................................................................................................... 2 - 2

3. SYSTEM CONFIGURATION .........................3 - 1 to 3 - 6
   3.1 System Configuration .................................................................................................................... 3 - 1
   3.2 Operating Environment ................................................................................................................ 3 - 1

4. INSTALLATION AND UNINSTALLATION ......4 - 1 to 4 - 13
   4.1 Starting the Menu Screen ............................................................................................................. 4 - 1
   4.2 Installing the Software Programs ................................................................................................ 4 - 2
       4.2.1 Software installing procedure .................................................................................................. 4 - 4
       4.2.2 Installing the manual data ....................................................................................................... 4 - 9
   4.3 Uninstalling the Software Programs ............................................................................................ 4 - 11
       4.3.1 Software uninstalling procedure ............................................................................................ 4 - 11
   4.4 Starting the Software .................................................................................................................... 4 - 13
5. HOW TO USE THE ONLINE MANUAL AND HELP ................................................................. 5 - 1 to 5 - 5

5.1 How to Use the Online Manual .................................................................................. 5 - 1
5.2 How to Use Help ........................................................................................................ 5 - 3
5.3 How to View the Product Information ...................................................................... 5 - 5

6. WHAT IS THE GOT? ........................................ 6 - 1 to 6 - 3

6.1 About the GOT ........................................................................................................... 6 - 1
6.2 About GOT Operation ............................................................................................... 6 - 2

7. CREATING THE MONITOR DATA .......... 7 - 1 to 7 - 25

7.1 Creating Screens ........................................................................................................ 7 - 1
  7.1.1 Screen configuration of GT Designer2 ........................................................................ 7 - 2
7.2 Setting before Screen Creation .................................................................................. 7 - 3
  7.2.1 Creating a project .................................................................................................. 7 - 3
  7.2.2 Creating the second screen .................................................................................... 7 - 6
  7.2.3 Setting the screen switching device ....................................................................... 7 - 6
  7.2.4 How to switch between the created screens ........................................................ 7 - 7
7.3 Drawing Figures and Inputting Texts ................................................................. 7 - 8
7.4 Setting the Object Function .................................................................................... 7 - 10
  7.4.1 Numerical Display/Numerical Input setting method ............................................ 7 - 11
  7.4.2 Lamp setting method .......................................................................................... 7 - 13
  7.4.3 Touch Switch (Bit Switch) setting method .......................................................... 7 - 15
  7.4.4 Touch Switch (GO TO Screen Switch) setting method ...................................... 7 - 18
  7.4.5 Alarm List (System Alarm) setting method ......................................................... 7 - 20
  7.4.6 Alarm List (User Alarm) setting method ............................................................. 7 - 21
7.5 Saving the Created Monitor Data ........................................................................... 7 - 24
7.6 Previewing the created project data ........................................................................ 7 - 25

8. EXECUTING MONITOR ON THE GOT ....... 8 - 1 to 8 - 9

8.1 Transferring Monitor Data from Personal Computer to GOT ................................ 8 - 1
  8.1.1 Connecting the personal computer and GOT ...................................................... 8 - 1
  8.1.2 Installing the Standard monitor OS and Communication driver ....................... 8 - 2
  8.1.3 Downloading the monitor data .......................................................................... 8 - 3
8.2 Connecting with the PLC CPU .................................................................................. 8 - 4
8.3 Uploading .................................................................................................................. 8 - 8
## Function Quick Reference

### Edit Operation (GT Designer2 Version Operating Manual)

<table>
<thead>
<tr>
<th>Image</th>
<th>Function</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Preview" /></td>
<td>Show the preview of screen image of GOT.</td>
<td>Page 4-43</td>
</tr>
<tr>
<td><img src="image" alt="Align" /></td>
<td>Aligns objects or images</td>
<td>Page 8-22</td>
</tr>
<tr>
<td><img src="image" alt="Property sheet" /></td>
<td>Sets same attributes to objects or images in the same screen</td>
<td>Page 9-1</td>
</tr>
<tr>
<td><img src="image" alt="Guidelines" /></td>
<td>Displays lines to align figures and objects when arranging a placed figure or object.</td>
<td>Page 8-25</td>
</tr>
<tr>
<td><img src="image" alt="Replace colors" /></td>
<td>Changes the color(s) of the objects and figures arranged on plural screens at the same time</td>
<td>Page 9-12</td>
</tr>
<tr>
<td><img src="image" alt="Replace shapes" /></td>
<td>Changes the switch/lamp figures at the same time</td>
<td>Page 9-12</td>
</tr>
<tr>
<td><img src="image" alt="Replace devices" /></td>
<td>Changes the preset devices at the same time</td>
<td>Page 9-12</td>
</tr>
<tr>
<td><img src="image" alt="Data View" /></td>
<td>Overlapping images or objects</td>
<td>Page 9-16</td>
</tr>
<tr>
<td><img src="image" alt="Device list" /></td>
<td>Display the set device in list</td>
<td>Page 9-17</td>
</tr>
<tr>
<td>Image</td>
<td>Function</td>
<td>Page</td>
</tr>
<tr>
<td>-------</td>
<td>----------</td>
<td>------</td>
</tr>
<tr>
<td><img src="image" alt="Text list" /></td>
<td>Displays the direct input texts in a list.</td>
<td>Page 9-19</td>
</tr>
<tr>
<td><img src="image" alt="Multiple language input" /></td>
<td>Input characters or comments in other language.</td>
<td>Page 9-24</td>
</tr>
<tr>
<td><img src="image" alt="Import BMP/DXF file" /></td>
<td>Imports BMP/DXF files</td>
<td>Page 8-13</td>
</tr>
<tr>
<td><img src="image" alt="Import Project" /></td>
<td>Utilizes other project data</td>
<td>Page 9-33</td>
</tr>
<tr>
<td>Lamp, Touch Switch</td>
<td>Image</td>
<td>Function</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------</td>
<td>----------</td>
</tr>
<tr>
<td><strong>Lamp</strong></td>
<td><img src="run-stop.png" alt="Image" /></td>
<td>Displays device value via lamp color changing</td>
</tr>
<tr>
<td><strong>Bit Switch</strong></td>
<td><img src="bit-switch.png" alt="Image" /></td>
<td>Touch it to switch device ON/OFF</td>
</tr>
<tr>
<td><strong>Data Set Switch</strong></td>
<td><img src="data-set-switch.png" alt="Image" /></td>
<td>Touch it to change bit device value</td>
</tr>
<tr>
<td><strong>Special Function Switch</strong></td>
<td><img src="special-function-switch.png" alt="Image" /></td>
<td>Touch it to switch to the extended function screen</td>
</tr>
<tr>
<td><strong>GO TO Screen Switch</strong></td>
<td><img src="go-to-screen-switch.png" alt="Image" /></td>
<td>Touch it to switch between the base and window screen</td>
</tr>
<tr>
<td><strong>Change Station Switch</strong></td>
<td><img src="change-station-switch.png" alt="Image" /></td>
<td>Touch it to switch the monitored PLC station No.</td>
</tr>
<tr>
<td><strong>Key Code Switch</strong></td>
<td><img src="key-code-switch.png" alt="Image" /></td>
<td>Used as the key for inputting numerical value/ASCII</td>
</tr>
</tbody>
</table>
## 2 Digit/Font Display

<table>
<thead>
<tr>
<th>Image</th>
<th>Function</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Numerical Display" /></td>
<td>Displays device value in numerical value</td>
<td>Page 7-1</td>
</tr>
<tr>
<td><img src="image2.png" alt="Numerical Input" /></td>
<td>Write value on device</td>
<td>Page 7-1</td>
</tr>
<tr>
<td><img src="image3.png" alt="Data List" /></td>
<td>Display multiple device value in list</td>
<td>Page 7-28</td>
</tr>
<tr>
<td><img src="image4.png" alt="ASCII Display" /></td>
<td>Displays device value in text</td>
<td>Page 7-44</td>
</tr>
<tr>
<td><img src="image5.png" alt="ASCII Input" /></td>
<td>Inputs text code device</td>
<td>Page 7-44</td>
</tr>
<tr>
<td><img src="image6.png" alt="Clock Display" /></td>
<td>Displays hour/minutes, year/month/date</td>
<td>Page 7-57</td>
</tr>
<tr>
<td><img src="image7.png" alt="Comment Display" /></td>
<td>Displays command</td>
<td>Page 7-63</td>
</tr>
</tbody>
</table>

## 3 Alarm

<table>
<thead>
<tr>
<th>Image</th>
<th>Function</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image8.png" alt="Alarm List" /></td>
<td>Displays message at alarm occurrence</td>
<td>Page 8-1</td>
</tr>
<tr>
<td><img src="image9.png" alt="Alarm History" /></td>
<td>Displays alarm history</td>
<td>Page 8-31</td>
</tr>
<tr>
<td><img src="image10.png" alt="Floating Alarm" /></td>
<td>Displays alarm in floating</td>
<td>Page 8-67</td>
</tr>
</tbody>
</table>
## Parts

<table>
<thead>
<tr>
<th>Image</th>
<th>Function</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Parts Display" /></td>
<td>Display entered device</td>
<td>Page 9-1</td>
</tr>
</tbody>
</table>

## Graph, Meter

<table>
<thead>
<tr>
<th>Image</th>
<th>Function</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Panel meter" /></td>
<td>Displays device data on panel meter</td>
<td>Page 10-1</td>
</tr>
<tr>
<td><img src="image" alt="Level" /></td>
<td>Displays device data in proportional level</td>
<td>Page 10-14</td>
</tr>
<tr>
<td><img src="image" alt="Trend Graph" /></td>
<td>Displays device data in trend graph</td>
<td>Page 10-28</td>
</tr>
<tr>
<td><img src="image" alt="Line Graph" /></td>
<td>Displays device data in line graph</td>
<td>Page 10-44</td>
</tr>
<tr>
<td><img src="image" alt="Bar Graph" /></td>
<td>Displays device data in bar graph</td>
<td>Page 10-59</td>
</tr>
<tr>
<td><img src="image" alt="Statistics Graph" /></td>
<td>Displays device data in statistics graph</td>
<td>Page 10-71</td>
</tr>
<tr>
<td><img src="image" alt="Scatter Graph" /></td>
<td>Displays device data in scatter graph</td>
<td>Page 10-81</td>
</tr>
<tr>
<td><img src="image" alt="Sampling" /></td>
<td>Collect the device value and edit collected data on PC</td>
<td>Page 10-102</td>
</tr>
</tbody>
</table>
## 6 Trigger → action

<table>
<thead>
<tr>
<th>Image</th>
<th>Function</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status observation function</td>
<td>Monitors status of device and write value to device or operates GOT when condition meets</td>
<td>Page 11-1</td>
</tr>
<tr>
<td>Recipe function</td>
<td>Monitors status of device and write/read device data when condition meets</td>
<td>Page 11-12</td>
</tr>
<tr>
<td>Time action function</td>
<td>Outputs the device writing and sound at specified time.</td>
<td>Page 11-22</td>
</tr>
</tbody>
</table>

## 7 External input/output

<table>
<thead>
<tr>
<th>Image</th>
<th>Function</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report</td>
<td>Collects numerical data when condition meets and prints the numerical data and corresponding code.</td>
<td>Page 12-1</td>
</tr>
<tr>
<td>Hardcopy</td>
<td>Outputs the GOT monitor screen to printer or memory card</td>
<td>Page 12-25</td>
</tr>
<tr>
<td>Operation panel</td>
<td>Uses operation panel to execute device writing</td>
<td>Page 12-31</td>
</tr>
<tr>
<td>Bar code</td>
<td>Writes data read by barcode reader to device</td>
<td>Page 12-39</td>
</tr>
<tr>
<td>Sound</td>
<td>Outputs sounds</td>
<td>Page 12-46</td>
</tr>
<tr>
<td>Video</td>
<td>Displays video</td>
<td>Page 12-50</td>
</tr>
<tr>
<td>RGB display</td>
<td>Displays PC screens</td>
<td>Page 12-68</td>
</tr>
</tbody>
</table>
## 8 Others

<table>
<thead>
<tr>
<th>Image</th>
<th>Function</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Set overlay screen" /></td>
<td>Set overlay screen from other screens</td>
<td>Page 13-1</td>
</tr>
<tr>
<td><img src="image" alt="Test" /></td>
<td>Changes device value via test window in monitor screen</td>
<td>Page 13-10</td>
</tr>
</tbody>
</table>

## 9 Script function

<table>
<thead>
<tr>
<th>Image</th>
<th>Function</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Script" /></td>
<td>Controls GOT display by scripts</td>
<td>Page 14-1</td>
</tr>
</tbody>
</table>

## 10 Object setting

<table>
<thead>
<tr>
<th>Image</th>
<th>Function</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Data operation" /></td>
<td>Operates device values by expression and enables objects using the operated value</td>
<td>Page 5-45</td>
</tr>
<tr>
<td><img src="image" alt="Offset" /></td>
<td>Accumulates the offset device value in monitor device address and monitor</td>
<td>Page 5-52</td>
</tr>
<tr>
<td><img src="image" alt="Security" /></td>
<td>Restricts the password users</td>
<td>Page 5-56</td>
</tr>
</tbody>
</table>
## Data Transmission (GT Designer2 Version\square Operating Manual)

<table>
<thead>
<tr>
<th>Image</th>
<th>Function</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="download_image.png" alt="Download Image" /></td>
<td>Transmits monitor screen data from PC to GOT</td>
<td>Page 5-1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Image</th>
<th>Function</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="upload_image.png" alt="Upload Image" /></td>
<td>Transmits monitor screen data from GOT to PC</td>
<td>Page 5-20</td>
</tr>
</tbody>
</table>

## Print3 (GT Designer2 Version\square Operating Manual)

<table>
<thead>
<tr>
<th>Image</th>
<th>Function</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="print_screen_image.png" alt="Print Screen Image" /></td>
<td>Print base/window/report screen</td>
<td>Page 6-1</td>
</tr>
</tbody>
</table>
Manuals

Relevant Manual

For relevant manual, refer to the PDF manual stored within the drawing software.
## Abbreviations and Generic Terms

Abbreviations and generic terms used in this manual are as follows:

### GOT

<table>
<thead>
<tr>
<th>Abbreviations and generic terms</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>GOT-A900 series</strong></td>
<td></td>
</tr>
<tr>
<td>A985GOT-V</td>
<td>A985GOT-TBA-V, A985GOT-TBD-V</td>
</tr>
<tr>
<td>A985GOT</td>
<td>A985GOT-TBA, A985GOT-TBD, A985GOT-TBA-EU</td>
</tr>
<tr>
<td>A975GOT</td>
<td>A975GOT-TBA-B, A975GOT-TBA-EU</td>
</tr>
<tr>
<td>A970GOT</td>
<td>A970GOT-TBA-B, A970GOT-TBA-EU</td>
</tr>
<tr>
<td>A97*GOT</td>
<td>A975GOT-TBA-EU, A975GOT-TBA-EU</td>
</tr>
<tr>
<td>A960GOT</td>
<td>A960GOT-EBB, A960GOT-EBD, A960GOT-EBB-EU</td>
</tr>
<tr>
<td>A956WGOT</td>
<td>A956WGOT-TBD</td>
</tr>
<tr>
<td>A953GOT</td>
<td>A953GOT-TBD, A953GOT-TBD-M3, A953GOT-TBD-M3-B</td>
</tr>
<tr>
<td>A951GOT-Q</td>
<td>A951GOT-TBD-Q, A951GOT-TBD-QM3, A951GOT-TBD-QM3-B</td>
</tr>
<tr>
<td>A950GOT-Q</td>
<td>A950GOT-TBD-Q, A950GOT-TBD-QM3, A950GOT-TBD-QM3-B</td>
</tr>
<tr>
<td>A95*handy GOT</td>
<td>A950GOT-TBD-M3-H, A950GOT-TBD-M3-H</td>
</tr>
<tr>
<td>A95*GOT</td>
<td>A950GOT-TBD-M3-H, A950GOT-TBD-M3-H</td>
</tr>
<tr>
<td><strong>GOT-F900 series</strong></td>
<td></td>
</tr>
<tr>
<td>F940GOT</td>
<td>F940GOT-SWD, F940GOT-LWD, ET-940BH(-L), ET-940PH(-L)</td>
</tr>
<tr>
<td><strong>GOT1000 series</strong></td>
<td>Generic name of GOT1000 series</td>
</tr>
</tbody>
</table>

### Communication board/communication module

<table>
<thead>
<tr>
<th>Abbreviations and generic terms</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Communication board</strong></td>
<td></td>
</tr>
<tr>
<td>Bus connection board</td>
<td>A9GT-UBUS, A9GT-UBUS-S, A9GT-UBUS-S-S</td>
</tr>
<tr>
<td>Serial communication board</td>
<td>A9GT-UBUS-S, A9GT-UBUS-S-S</td>
</tr>
<tr>
<td><strong>Communication module</strong></td>
<td></td>
</tr>
<tr>
<td>Bus connection module</td>
<td>A9GT-UBUS-S, A9GT-UBUS-S-S, A9GT-UBUS-S</td>
</tr>
<tr>
<td>Data link module</td>
<td>A9GT-UBUS-S-S, A9GT-UBUS-S-S-S</td>
</tr>
<tr>
<td>Network module</td>
<td>A9GT-UBUS-S-S-S, A9GT-UBUS-S-S-S-S</td>
</tr>
<tr>
<td>CC-Link communication module</td>
<td>A9GT-UBUS-S-S-S-S, A9GT-UBUS-S-S-S-S-S</td>
</tr>
<tr>
<td>Ethernet communication module</td>
<td>A9GT-UBUS-S-S-S-S-S, A9GT-UBUS-S-S-S-S-S-S</td>
</tr>
</tbody>
</table>
### Option Module

<table>
<thead>
<tr>
<th>Abbreviations and generic terms</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>External I/O module</td>
<td>A9GT-70KBF, A8GT-50KBF</td>
</tr>
<tr>
<td>Printer interface module</td>
<td>A9GT-50PRF type</td>
</tr>
<tr>
<td>Memory card interface module</td>
<td>A1SD59J-MIF</td>
</tr>
<tr>
<td>Video/RGB mixed input interface module</td>
<td>A9GT-80V4R1</td>
</tr>
<tr>
<td>Video input interface module</td>
<td>A9GT-80V4</td>
</tr>
<tr>
<td>RGB input interface module</td>
<td>A9GT-80R1</td>
</tr>
</tbody>
</table>

### Option

<table>
<thead>
<tr>
<th>Abbreviations and generic terms</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backlight</td>
<td>A9GT-80LTT, A9GT-70LTTB, A9GT-70LTT, A9GT-70LT, F9GT-40LTS, F9GT-30LTS</td>
</tr>
<tr>
<td>Debug stand</td>
<td>A9GT-80STAND, A9GT-70STAND, A9GT-50WSTAND, A9GT-50STAND</td>
</tr>
<tr>
<td>Memory board</td>
<td>A9GT-FNB, A9GT-FNB1M, A9GT-QFN801M, A9GT-QFN804M, A9GT-QFN808M, A9GT-QFN808M</td>
</tr>
<tr>
<td>Ten-key panel</td>
<td>A8GT-TK</td>
</tr>
<tr>
<td>Bus connector conversion box</td>
<td>A7GT-CNB</td>
</tr>
<tr>
<td>Bus distance connector box</td>
<td>A9GT-QCNB</td>
</tr>
<tr>
<td>Attachment</td>
<td>A77GT-96ATT, A85GT-96ATT, A8GT-96ATT, A8GT-96ATT</td>
</tr>
<tr>
<td>Memory card</td>
<td>Flash PC card/Commercially available flash PC card/SRAM type PC card</td>
</tr>
<tr>
<td>Flash PC card</td>
<td>A9GTMEM-10MF, A9GTMEM-20MF, A9GTMEM-40MF</td>
</tr>
<tr>
<td>Compact Flash PC card</td>
<td>Commercially available flash PC card</td>
</tr>
<tr>
<td>Connector conversion box</td>
<td>F9GT-HCNB</td>
</tr>
</tbody>
</table>

### Software

<table>
<thead>
<tr>
<th>Abbreviations and generic terms</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GT Works2 Version[]</td>
<td>SWD5C-GTWK2-E, SWD5C-GTWK2-EV</td>
</tr>
<tr>
<td>GT Designer2 Version[]</td>
<td>Abbreviation of SWD5C-GTD2-E</td>
</tr>
<tr>
<td>GT Designer2</td>
<td>Abbreviation of GOT900 series graphic software-GT Designer2</td>
</tr>
<tr>
<td>GT SoftGOT2</td>
<td>Abbreviation of monitoring software-GT SoftGOT2</td>
</tr>
<tr>
<td>GT Converter2</td>
<td>Abbreviation of GOT900 series data conversion software-GT Converter</td>
</tr>
<tr>
<td>GX Developer</td>
<td>Abbreviation of SWD5C-GPPW(-V)/SWD5F-GPPW(-V) type software package</td>
</tr>
<tr>
<td>GX Simulator</td>
<td>Abbreviation of SWD5C-LLT(-V) type download test tool function software package (SW5D5C-LLT(-V) or later)</td>
</tr>
</tbody>
</table>
### License (for GT SoftGOT, GT SoftGOT2)

<table>
<thead>
<tr>
<th>License</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A9GTSOFT-LKEY-P</td>
<td>A9GTSOFT-LKEY-P (for DOS/VPC)</td>
</tr>
<tr>
<td>SW5D5F-SGLKEY-J</td>
<td>SW5D5F-SGLKEY-J (for PC CPU module)</td>
</tr>
</tbody>
</table>

### CPU

<table>
<thead>
<tr>
<th>CPU Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>QCPU</td>
<td>QCPU (Q Mode)</td>
</tr>
<tr>
<td></td>
<td>QCPU (A Mode)</td>
</tr>
<tr>
<td></td>
<td>Remote I/O station</td>
</tr>
<tr>
<td>QnACPU</td>
<td>QnACPU type</td>
</tr>
<tr>
<td></td>
<td>QnASCPU type</td>
</tr>
<tr>
<td>ACPU</td>
<td>ACPU type</td>
</tr>
<tr>
<td></td>
<td>ACPU type (H)</td>
</tr>
<tr>
<td></td>
<td>ACPU type (S)</td>
</tr>
<tr>
<td></td>
<td>ACPU type (S) (H)</td>
</tr>
<tr>
<td></td>
<td>ACPU type (F)</td>
</tr>
<tr>
<td>FXCPU</td>
<td>FXCPU</td>
</tr>
<tr>
<td></td>
<td>Motion controller CPU (Q series)</td>
</tr>
<tr>
<td></td>
<td>Motion controller CPU (A series)</td>
</tr>
<tr>
<td>FA controller</td>
<td>FA controller</td>
</tr>
<tr>
<td>MELDAS C6/C64</td>
<td>MELDAS C6/C64</td>
</tr>
</tbody>
</table>
How to Use This Manual

Specification of symbols used in this manual

4.4 Starting the Software

Point

(1) When GT SoftGOT2 has been installed in the PC CPU module
When GT SoftGOT2 installed in the PC CPU module is used, a license must be registered to the PC CPU module using the license key FD.
Refer to the following manual for the license key FD registration method.
\[GT\ \text{SoftGOT2 Version1 Operating Manual}\]

(2) Precautions for starting Adobe Acrobat Reader
The Software License Agreement is displayed when an attempt is made to start Adobe Acrobat Reader after installing it.
Read this Software License Agreement carefully and select "Accept" to view the PDF data, such as the online manual.
Adobe Acrobat Reader will not start if an attempt is made to view the PDF data before selecting "Accept".
In this case, restarting the personal computer and selecting "Accept" in the above method allows Adobe Acrobat Reader to be used.

\[
\begin{align*}
&1. \text{Click the menu of the software package to be started.} \\
&\quad \text{In the case of GT Designer2, GT SoftGOT2 or GT Converter2: Make selection from [Start] \rightarrow [All Programs] \rightarrow [GTSOFT Application].} \\
&\quad \text{In the case of Adobe Acrobat Reader: Make selection from [Start] \rightarrow [All Programs].} \\
\end{align*}
\]

\[
\begin{align*}
&2. \text{The corresponding software package starts.} \\
&\quad \text{(When GT Designer2 is started)}
\end{align*}
\]
Product List

The following shows the product list of GT Works2 or GT Designer2.

- SW2DSC-GTWK2-E(V)
- SW2DSC-GTD2-E(V)

About installation method of GT Works2/GT Designer2
End-user software license agreement
Software registration form
License agreement

NOTICES

- We don't guarantee the commercially-available Microsoft® Windows® Operating System-based software products that have been introduced in this manual.
- We hold the copyrights of this software package.
- No part of this manual may be transcribed or duplicated in any form without prior permission by Mitsubishi Electric Corporation.
- We have attempted to cover all the revisions of software and hardware, but this manual may not contain the latest revisions.
- The software of this product requires one license to be purchased per computer.
- We permit the user to use this software package (including this manual) based on the Software License Agreement.
- We are not liable for consequences or influences due to this software package (including this manual).
- The specifications of this software package and the descriptions in this manual may be altered in future without prior notice.
1. OVERVIEW

This manual explains the system configuration, installation method and PDF manual viewing method of the GOT900 series drawing software package (GT Works2 Version2, GT Designer2 Version2). In and after Chapter 7 of this manual, an example of creating simple screens using GT Designer2 will be explained.

For those who uses the GOT for the first time, it is recommended to operate the GOT and GT Designer2 actually in the procedures given in and after Chapter 7 to learn the operation method. When applying the following program examples to the actual system, make sure to examine the applicability and confirm that it will not cause system control problems.

**Remark**

About the data created in and after Chapter 7

The monitor data and sequence program created in and after Chapter 7 of this manual are packed with GT Designer2.

Use them as necessary for confirming the set data, etc.

1.1 When Conventional Software Is Used

GT Works2 Version2, GT Designer2 Version2 may not be installed when the conventional GOT900 series software has been installed in the personal computer.

The following describes whether each software can be installed or not when the conventional software has been installed.

1. **GT Designer**
   
   If GT Designer has been installed in the personal computer, GT Designer2 can be installed.

2. **GT SoftGOT**
   
   If GT SoftGOT has been installed in the personal computer, GT SoftGOT2 cannot be installed. Before installing GT SoftGOT2, uninstall GT SoftGOT.

3. **GT Converter**
   
   GT Works2 Version2, GT Designer2 Version2 store latest GT Converter. When using GT Converter, it is recommended to use GT Converter that is stored in GT Works2 Version2, GT Designer2 Version2.

   If GT Converter of GT Designer has been installed in the personal computer, GT Designer2 Version1 can be installed.
## 1.2 About Manuals

Including this manual, there are three different manuals that are related to GT Designer2. Refer to the corresponding manual according to the purpose of use. The following manuals are stored in the product in a PDF format.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Install the product into the personal computer</td>
<td>Details</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create a project</td>
<td>Overview</td>
<td></td>
<td>Details</td>
</tr>
<tr>
<td>Create screens</td>
<td>Overview</td>
<td></td>
<td>Details</td>
</tr>
<tr>
<td>Draw figures</td>
<td>Overview</td>
<td></td>
<td>Details</td>
</tr>
<tr>
<td>Make common settings</td>
<td>Overview</td>
<td></td>
<td>Details</td>
</tr>
<tr>
<td>Arrange/set objects</td>
<td>Overview</td>
<td></td>
<td>Details</td>
</tr>
<tr>
<td>Transfer data to the GOT</td>
<td>Overview</td>
<td></td>
<td>Details</td>
</tr>
</tbody>
</table>

- **Startup•Introductory Manual**
  - Describes the installation method of the product.
  - Also gives an example of creating simple screens and using them on the GOT.

- **Reference Manual**
  - Describes the object, figure and screen specifications, object setting methods, etc.

- **Operating Manual**
  - Describes the GT Designer2 screen configuration, screen customizing method, and project creation and data transfer methods.
2. SOFTWARE PACKAGE CONFIGURATION

This chapter explains the software and data stored in the CD-ROMs of GT Works2 Version2 and GT Designer2 Version2.

2.1 Software

GT Works2 Version2 and GT Designer2 Version2 store the following software programs. The stored software programs differ between GT Works2 Version2 and GT Designer2 Version2.

<table>
<thead>
<tr>
<th>Software Name</th>
<th>Description</th>
<th>GT Works2</th>
<th>GT Designer2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>GOT-1000 series, GOT-900 series software</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GT Designer2</td>
<td>Creates screens for the GOT1000 series and GOT-900 series.</td>
<td>☑️</td>
<td>☑️</td>
</tr>
<tr>
<td>GT SoftGOT1000</td>
<td>Enables a PC to operate as the GOT-1000 series. The license key or license key FD is required to use this software.</td>
<td>☑️</td>
<td>☑️</td>
</tr>
<tr>
<td>GT SoftGOT2</td>
<td>Enables a PC to operate as the GOT-A900 series. The license key or license key FD is required to use this software. (Operates for about 10 minutes without license key/license key FD.) For the license key or license key FD, please contact your local Mitsubishi service center or representative.</td>
<td>☑️</td>
<td>☑️</td>
</tr>
<tr>
<td>GT Simulator2</td>
<td>Software that allows the GOT operation to be simulated on a personal computer connected with GX Simulator or PLC CPU.</td>
<td>☑️</td>
<td>—</td>
</tr>
<tr>
<td>GT Converter2</td>
<td>Converts the project data for GOT-800 series or Digital's package data into a GT Designer2 format file. GT Converter2 is not required to convert the project data for GOT-900 series to those for GOT1000 series.</td>
<td>☑️</td>
<td>☑️</td>
</tr>
<tr>
<td>MES DB Connection Service</td>
<td>Software for the GOT1000 series. MES interface function on GOT can be used by installing this software on a PC for server.</td>
<td>☑️</td>
<td>☑️</td>
</tr>
<tr>
<td>Document Converter</td>
<td>Creates the data for the GT Designer2 document display function for the GOT-1000 series.</td>
<td>☑️</td>
<td>☑️</td>
</tr>
<tr>
<td>Data Transfer Tool</td>
<td>Software for the GOT1000, GOT900, and GOT800 series. Enables downloading data from a PC and uploading data to a GOT with the PC that GT Designer2 or GOT800 series software is not installed.</td>
<td>☑️</td>
<td>☑️</td>
</tr>
<tr>
<td><strong>GOT-1000 series software</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GT MMData Connector</td>
<td>Automatically transfers the recorded files via Ethernet from the GOT with a multimedia unit installed to a personal computer, and displays them as a list.</td>
<td>☑️</td>
<td>☑️</td>
</tr>
</tbody>
</table>
## 2.2 Other Included Data

In addition to the software in Section 2.1, GT Works2 Version2 and GT Designer2 Version 2 includes the following data.

The following data are installed into the PC together with GT Designer2, GT Manual 1000 and GT Manual 900.

<table>
<thead>
<tr>
<th>GOT series</th>
<th>Data</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GOT1000 series</td>
<td>GT15 specific function sample data</td>
<td>Sample screen data for specific function of GT15.</td>
</tr>
<tr>
<td>GOT1000 series</td>
<td>Microcomputer connection sample data</td>
<td>Sample screen data and sample program (C language) for microcomputer connection.</td>
</tr>
<tr>
<td>GOT1000 series</td>
<td>Introduction data</td>
<td>Screen data used for explanation in Chapter 4 of the GT Designer2 Version2 Basic Operation/ Data Transfer Manual. To operate the screen data actually, write the sequence program stored in the &quot;Ladder&quot; folder to the PLC CPU with GX Developer.</td>
</tr>
<tr>
<td>GOT1000 series</td>
<td>Online manual</td>
<td>Online manual related to the GOT1000 series. It is stored in PDF data format.</td>
</tr>
<tr>
<td>GOT900 series</td>
<td>Function-specific sample data for A975GOT</td>
<td>Sample screen data for specific function of A975GOT. To operate the screen data actually, write the sequence program stored in the &quot;Ladder&quot; folder to the PLC CPU with GX Developer.</td>
</tr>
<tr>
<td>GOT900 series</td>
<td>Sample data for F940GOT/F940WGOT</td>
<td>Sample screen data for F940GOT/F940WGOT.</td>
</tr>
<tr>
<td>GOT900 series</td>
<td>Sample data for microcomputer connection</td>
<td>Sample screen data and sample program (C language) for microcomputer connection.</td>
</tr>
<tr>
<td>GOT900 series</td>
<td>Introduction data</td>
<td>Screen data used for explanation in Chapter 7 and later of this Manual. To operate the screen data actually, write the sequence program stored in the &quot;Ladder&quot; folder to the PLC CPU with GX Developer.</td>
</tr>
<tr>
<td>GOT900 series</td>
<td>256-color test data</td>
<td>Data for checking the color display of the screen data with 256-color pattern settings.</td>
</tr>
<tr>
<td>GOT900 series</td>
<td>Online manual</td>
<td>Online manual related to the GOT900 series. It is stored in PDF data format.</td>
</tr>
</tbody>
</table>
After GT Designer2, GT Manual 1000 and GT Manual 900 have been installed, the data are stored into the following folders.

**MELSEC** Installation destination folder (Default: `\MELSEC`)
- **GTD2**
  - `Example900` Sample screen data for GOT900 series
  - `Example1000` Sample screen data for GOT1000 series
  - `Fonts` Fonts for GOT1000 series *1
  - `Gmdp` Special data for GOT900 series *1
  - `Gmdp1000` Special data for GOT1000 series *1
  - `OS` OS for GOT900 series *1
  - `LibraryData` Library data disclosed on the MELFANS Web page
  - `OS1000` OS for GOT1000 series *1
  - `SysLib1000` System library data for GOT1000 series
  - `SysLibA900` System library data for GOT-A900
  - `SysLibF900` System library data for GOT-F900
    *1 Do not delete the folder or touch the folder data.

**MANUAL**
- **GT MANUAL**
  - `GTM900` GOT900 series related manual
  - `GTM1000` GOT1000 series related manual
  - `IndexGTM900-E.pdf` INDEX MENU for GOT900 series related manual
  - `IndexGTM1000-E.pdf` INDEX MENU for GOT1000 series related manual
3. SYSTEM CONFIGURATION

3.1 System Configuration

The system configuration is shown below.

IBM-PC/AT-compatible personal computer

GT Works2 Version2 or GT Designer2 Version2

3.2 Operating Environment

The following tables indicate the operating environment of the GOT900 series software stored in GT Works2 Version2 and GT Designer2 Version2.

1 GT Designer2
The following table indicates the operating environment of GT Designer2.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Personal computer</td>
<td>PC/AT compatible personal computer that Windows® runs on</td>
</tr>
<tr>
<td>Operating system</td>
<td>Microsoft® Windows® 98 Operating System (English, Simplified Chinese, Traditional Chinese, Korean, German versions)</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® Millennium Edition Operating System (English, Simplified Chinese, Traditional Chinese, Korean, German versions)</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows NT® Workstation 4.0 Operating System Service Pack 3 or later (English, Simplified Chinese, Traditional Chinese, Korean, German versions)</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® 2000 Professional Operating System Service Pack 4 or later (English, Simplified Chinese, Traditional Chinese, Korean, German versions)</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® XP Professional Operating System Service Pack 2 or later (English, Simplified Chinese, Traditional Chinese, Korean, German versions)</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® XP Home Edition Operating System Service Pack 2 or later (English, Simplified Chinese, Traditional Chinese, Korean, German versions)</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® XP Ultimate Operating System (English, Simplified Chinese, Traditional Chinese, Korean, German versions)</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® XP Enterprise Operating System (English, Simplified Chinese, Traditional Chinese, Korean, German versions)</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® XP Business Operating System (English, Simplified Chinese, Traditional Chinese, Korean, German versions)</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® Vista® Ultimate Operating System (English, Simplified Chinese, Traditional Chinese, Korean, German versions)</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® Vista® Enterprise Operating System (English, Simplified Chinese, Traditional Chinese, Korean, German versions)</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® Vista® Business Operating System (English, Simplified Chinese, Traditional Chinese, Korean, German versions)</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® Vista® Home Premium Operating System (English, Simplified Chinese, Traditional Chinese, Korean, German versions)</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® Vista® Home Basic Operating System (English, Simplified Chinese, Traditional Chinese, Korean, German versions)</td>
</tr>
<tr>
<td>Computer</td>
<td>Refer to &quot;Applicable operating system and performance required for personal computer&quot; on the next page.</td>
</tr>
<tr>
<td>CPU</td>
<td>For installation: 1.1GB or more ^7</td>
</tr>
<tr>
<td>Memory</td>
<td>For execution: 100MB or more</td>
</tr>
<tr>
<td>Hard disk space</td>
<td>For installation: 1.1GB or more ^7</td>
</tr>
<tr>
<td>Disk drive</td>
<td>CD-ROM drive</td>
</tr>
</tbody>
</table>
**Item** | **Description**
--- | ---
Display color | High Color (16 bits) or more
Display*6 | Resolution 800 × 600 dots or more
Others | Internet Explorer 5.0 or later must be installed.

*1: Administrator authority is required for installing GT Designer2.
*2: Administrator authority is required for installing and using GT Designer2.
*3: Administrator authority is required for installing GT Designer2.
A standard user or Administrator account is required for using GT Designer2.
For interactions between GT Designer2 and the other MELSOFT applications, use GT Designer2 under Administrator authority when the other applications are used under Administrator authority.

*4: The following functions are not supported.
   - "Compatibility mode"
   - "Fast user switching"
   - "Change your desktop themes (fonts)"
   - "Remote desktop"

*5: Only the 32-bit OS is available.

*6: For using the MES interface function, a display resolution of 1024 × 768 dots or more is required.

*7: 800MB or more when using Windows® 98, Windows® Millennium Edition or Windows NT®.

### Applicable operating system and performance required for personal computer

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Performance required for personal computer</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CPU</strong></td>
<td><strong>Memory</strong></td>
</tr>
<tr>
<td>Microsoft® Windows® 98 Operating System (English, Simplified Chinese, Traditional Chinese, Korean, German versions)</td>
<td>Pentium® 200MHz or more</td>
</tr>
<tr>
<td>Microsoft® Windows® Millennium Edition Operating System (English, Simplified Chinese, Traditional Chinese, Korean, German versions)</td>
<td>Pentium® 200MHz or more</td>
</tr>
<tr>
<td>Microsoft® Windows® NT® Workstation 4.0 Operating System Service Pack3 or later (English, Simplified Chinese, Traditional Chinese, Korean, German versions)</td>
<td>Pentium® 200MHz or more</td>
</tr>
<tr>
<td>Microsoft® Windows® 2000 Professional Operating System Service Pack4 or later (English, Simplified Chinese, Traditional Chinese, Korean, German versions)</td>
<td>Pentium® 200MHz or more</td>
</tr>
<tr>
<td>Microsoft® Windows® XP Professional Operating System Service Pack2 or later (English, Simplified Chinese, Traditional Chinese, Korean, German versions)</td>
<td>Pentium II® 300MHz or more</td>
</tr>
<tr>
<td>Microsoft® Windows® Vista® Ultimate Operating System (English, Simplified Chinese, Traditional Chinese, Korean, German versions)</td>
<td>Pentium® 200MHz or more</td>
</tr>
<tr>
<td>Microsoft® Windows® Vista® Enterprise Operating System (English, Simplified Chinese, Traditional Chinese, Korean, German versions)</td>
<td>Pentium® 200MHz or more</td>
</tr>
<tr>
<td>Microsoft® Windows® Vista® Business Operating System (English, Simplified Chinese, Traditional Chinese, Korean, German versions)</td>
<td>Pentium® 200MHz or more</td>
</tr>
<tr>
<td>Microsoft® Windows® Vista® Home Premium Operating System (English, Simplified Chinese, Traditional Chinese, Korean, German versions)</td>
<td>Pentium® 200MHz or more</td>
</tr>
<tr>
<td>Microsoft® Windows® Vista® Home Basic Operating System (English, Simplified Chinese, Traditional Chinese, Korean, German versions)</td>
<td>Pentium® 200MHz or more</td>
</tr>
</tbody>
</table>

---

**Note:**
- Administrator authority is required for installing GT Designer2.
- Administrator authority is required for installing and using GT Designer2.
- Administrator authority is required for installing GT Designer2.
- A standard user or Administrator account is required for using GT Designer2.
- For interactions between GT Designer2 and the other MELSOFT applications, use GT Designer2 under Administrator authority when the other applications are used under Administrator authority.
- The following functions are not supported:
  - "Compatibility mode"
  - "Fast user switching"
  - "Change your desktop themes (fonts)"
  - "Remote desktop"
- Only the 32-bit OS is available.
- For using the MES interface function, a display resolution of 1024 × 768 dots or more is required.
- 800MB or more when using Windows® 98, Windows® Millennium Edition or Windows NT®.
## GT Simulator2
The following table indicates the operating environment of GT Simulator2.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Personal computer</td>
<td>PC/AT compatible personal computer that Windows® runs on</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft® Windows® 98 Operating System (English, Simplified Chinese, Traditional Chinese, Korean, German versions)</td>
<td></td>
</tr>
<tr>
<td>Microsoft® Windows® Millennium Edition Operating System (English, Simplified Chinese, Traditional Chinese, Korean, German versions)</td>
<td></td>
</tr>
<tr>
<td>Microsoft® Windows NT® Workstation 4.0 Operating System (English, Simplified Chinese, Traditional Chinese, Korean, German versions)*1</td>
<td></td>
</tr>
<tr>
<td>Microsoft® Windows® 2000 Professional Operating System (English, Simplified Chinese, Traditional Chinese, Korean, German versions)*1</td>
<td></td>
</tr>
<tr>
<td>Microsoft® Windows® XP Professional Operating System (English, Simplified Chinese, Traditional Chinese, Korean, German versions)*2 *4 *5</td>
<td></td>
</tr>
<tr>
<td>Microsoft® Windows Vista® Ultimate Operating System (English, Simplified Chinese, Traditional Chinese, Korean, German versions)*3 *4 *5</td>
<td></td>
</tr>
<tr>
<td>Microsoft® Windows Vista® Enterprise Operating System (English, Simplified Chinese, Traditional Chinese, Korean, German versions)*3 *4 *5</td>
<td></td>
</tr>
<tr>
<td>Microsoft® Windows Vista® Business Operating System (English, Simplified Chinese, Traditional Chinese, Korean, German versions)*3 *4 *5</td>
<td></td>
</tr>
<tr>
<td>Microsoft® Windows Vista® Home Premium Operating System (English, Simplified Chinese, Traditional Chinese, Korean, German versions)*3 *4 *5</td>
<td></td>
</tr>
<tr>
<td>Microsoft® Windows Vista® Home Basic Operating System (English, Simplified Chinese, Traditional Chinese, Korean, German versions)*3 *4 *5</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Computer</th>
<th>Refer to “Applicable operating system and performance required for personal computer” on the next page.</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Refer to “Applicable operating system and performance required for personal computer” on the next page.</td>
</tr>
<tr>
<td>Memory</td>
<td>Refer to “Applicable operating system and performance required for personal computer” on the next page.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Hard disk space</th>
<th>For installation: 600MB or more</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>For execution: 100MB or more</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Disk drive</th>
<th>CD-ROM drive</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Display color</th>
<th>High Color (16 bits) or more</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Display*6</th>
<th>Resolution 800 x 600 dots or more</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Others</th>
<th>Internet Explorer 5.0 or later must be installed.</th>
</tr>
</thead>
</table>

*1: Administrator authority is required for installing GT Designer2.
*2: Administrator authority is required for installing and using GT Designer2.
*3: Administrator authority is required for installing GT Simulator2.
*4: The following functions are not supported.
  • “Compatibility mode”
  • “Fast user switching”
  • “Change your desktop themes (fonts)”
  • “Remote desktop”
*5: Only the 32-bit OS is available.
*6: For using the MES interface function, a display resolution of 1024 x 768 dots or more is required.
Applicable operating system and performance required for personal computer

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Performance required for personal computer</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>CPU</td>
</tr>
<tr>
<td>Microsoft® Windows® 98 Operating System</td>
<td>Pentium® 200MHz or more</td>
</tr>
<tr>
<td>(English, Simplified Chinese, Traditional Chinese, Korean, German versions)</td>
<td></td>
</tr>
<tr>
<td>Microsoft® Windows® Millennium Edition Operating System</td>
<td>Pentium® 200MHz or more</td>
</tr>
<tr>
<td>(English, Simplified Chinese, Traditional Chinese, Korean, German versions)</td>
<td></td>
</tr>
<tr>
<td>Microsoft® Windows® NT® Workstation 4.0 Operating System</td>
<td>Pentium® 200MHz or more</td>
</tr>
<tr>
<td>(English, Simplified Chinese, Traditional Chinese, Korean, German versions)</td>
<td></td>
</tr>
<tr>
<td>Microsoft® Windows® 2000 Professional Operating System</td>
<td>Pentium® 200MHz or more</td>
</tr>
<tr>
<td>(English, Simplified Chinese, Traditional Chinese, Korean, German versions)</td>
<td></td>
</tr>
<tr>
<td>Microsoft® Windows® XP Professional Operating System</td>
<td>Pentium II® 300MHz or more</td>
</tr>
<tr>
<td>(English, Simplified Chinese, Traditional Chinese, Korean, German versions)</td>
<td></td>
</tr>
<tr>
<td>Microsoft® Windows® XP Home Edition Operating System</td>
<td>Pentium II® 300MHz or more</td>
</tr>
<tr>
<td>(English, Simplified Chinese, Traditional Chinese, Korean, German versions)</td>
<td></td>
</tr>
<tr>
<td>Microsoft® Windows® Vista® Ultimate Operating System</td>
<td>Pentium II® 300MHz or more</td>
</tr>
<tr>
<td>(English, Simplified Chinese, Traditional Chinese, Korean, German versions)</td>
<td></td>
</tr>
<tr>
<td>Microsoft® Windows® Vista® Enterprise Operating System</td>
<td>Pentium II® 300MHz or more</td>
</tr>
<tr>
<td>(English, Simplified Chinese, Traditional Chinese, Korean, German versions)</td>
<td></td>
</tr>
<tr>
<td>Microsoft® Windows® Vista® Business Operating System</td>
<td>Pentium II® 300MHz or more</td>
</tr>
<tr>
<td>(English, Simplified Chinese, Traditional Chinese, Korean, German versions)</td>
<td></td>
</tr>
<tr>
<td>Microsoft® Windows® Vista® Home Premium Operating System</td>
<td>Pentium II® 300MHz or more</td>
</tr>
<tr>
<td>(English, Simplified Chinese, Traditional Chinese, Korean, German versions)</td>
<td></td>
</tr>
<tr>
<td>Microsoft® Windows® Vista® Home Basic Operating System</td>
<td>Pentium II® 300MHz or more</td>
</tr>
<tr>
<td>(English, Simplified Chinese, Traditional Chinese, Korean, German versions)</td>
<td></td>
</tr>
</tbody>
</table>

**Remark**

GX Simulator software version for simulating PLC CPU

The following table indicates PLC CPUs simulated and software version of the GX Simulator that simulates the PLC CPUs.

<table>
<thead>
<tr>
<th>PLC CPU simulated</th>
<th>Software version</th>
</tr>
</thead>
<tbody>
<tr>
<td>QCPU (A mode), ACPU, motion controller CPU</td>
<td>Version5 00A edition or later</td>
</tr>
<tr>
<td>QCPU (Q mode) (excluding Q00J/Q00/Q01CPU), QnACPU, FXCPU</td>
<td>Version5 00E edition or later</td>
</tr>
<tr>
<td>Q00JCPU, Q00CPU, Q01CPU</td>
<td>Version6.00A or later</td>
</tr>
<tr>
<td>Q12PHCPU, Q25PHCPU</td>
<td>Version6.10L or later</td>
</tr>
<tr>
<td>Q12PRHCPU, Q25PRHCPU</td>
<td>Version6.20W or later</td>
</tr>
</tbody>
</table>
The following table indicates the operating environment of GT SoftGOT2.

<table>
<thead>
<tr>
<th>Item</th>
<th>When IBM-PC/AT-compatible Personal Computer Is Used</th>
<th>When PC CPU Module Is Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>PC</td>
<td>PC/AT compatible PC on which Windows® will operate</td>
<td>MELSEC-Q series compatible PC CPU module manufactured by CONTEC</td>
</tr>
<tr>
<td>OS</td>
<td>Microsoft® Windows® 98 operating system</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® Millennium Edition operating system</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows NT® Workstation4.0 operating system</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® 2000 Professional operating system</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® XP Professional operating system</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® XP Home Edition operating system</td>
<td></td>
</tr>
<tr>
<td>CPU</td>
<td>Refer to the following &quot;Applicable operating system and the corresponding required PC performance&quot;.</td>
<td></td>
</tr>
<tr>
<td>Required memory</td>
<td>64M bytes or more (96M bytes or more recommended) (96M bytes or more (128M bytes or more recommended) when GT SoftGOT2 and GX Developer are used simultaneously or more than one GT SoftGOT2 are started.)</td>
<td></td>
</tr>
<tr>
<td>Available hard disk space</td>
<td>At installation : 200M bytes or more</td>
<td>At operation : 100M bytes or more *3</td>
</tr>
<tr>
<td></td>
<td>Disc drive</td>
<td>3.5 inch (1.44MB) floppy disk drive</td>
</tr>
<tr>
<td>Display color</td>
<td>256 colors</td>
<td></td>
</tr>
<tr>
<td>Display</td>
<td>Resolution 800 × 600 dots or more (640 × 480 dots or more when full screen display function is used)</td>
<td></td>
</tr>
<tr>
<td>Required software</td>
<td>GT Designer Version 5 Edition D or later or GT Designer2</td>
<td></td>
</tr>
<tr>
<td>Requirement license key/licence key FD</td>
<td>A9GTSOFT-LKEY-P *2</td>
<td>SW5D5F-SGLKEY-J</td>
</tr>
<tr>
<td>Valid OS</td>
<td>Japanese, English *6</td>
<td></td>
</tr>
</tbody>
</table>

*1 Use the personal computer where Windows NT® Workstation 4.0 of Service Pack 3 or later has been installed.

*2 To use the A9GTSOFT-LKEY-P, a parallel port (Centronics/printer connector) is required for the IBM-PC/AT-compatible personal computer.

*3 When more than one GT SoftGOT2 are started, "number of started GT SoftGOT2's × 100" M bytes are required. When the monitor screen data size (space) is large (30M bytes or more as a guideline), 200M bytes or more may be required.

*4 "Compatibility mode", "Fast user switching", "Changing desktop themes (font)" and "Remote desktop" are not supported.

*5 The administrator authority is required to install GT SoftGOT2 into Windows NT® Workstation 4.0, Windows® 2000 Professional, Windows® XP Professional or Windows® XP Home Edition. Also, the administrator authority is required to use GT Designer2 on Windows® XP Professional or Windows® XP Home Edition.

*6 Characters in the dialog box may not be properly displayed when OS other than the above is used.
### Basic software used and PC performance required

<table>
<thead>
<tr>
<th>Basic software</th>
<th>CPU</th>
<th>Required memory</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Basic software</strong></td>
<td><strong>Required PC performance</strong></td>
<td><strong>Required memory</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>GT SoftGOT2 only</strong></td>
</tr>
<tr>
<td>Microsoft® Windows® 98 operating system</td>
<td>Pentium® 200MHz or more (Pentium II® 300MHz or more recommended)</td>
<td>64MB or more (96MB or more recommended)</td>
</tr>
<tr>
<td>Microsoft® Windows® Me operating system</td>
<td>Pentium® 200MHz or more (Pentium II® 300MHz or more recommended)</td>
<td>64MB or more (96MB or more recommended)</td>
</tr>
<tr>
<td>Microsoft® WindowsNT® Workstation4.0 operating system</td>
<td>Pentium® 200MHz or more (Pentium II® 300MHz or more recommended)</td>
<td>64MB or more (96MB or more recommended)</td>
</tr>
<tr>
<td>Microsoft® Windows® 2000 Professional operating system</td>
<td>Pentium® 200MHz or more (Pentium II® 300MHz or more recommended)</td>
<td>64MB or more (96MB or more recommended)</td>
</tr>
<tr>
<td>Microsoft® Windows® XP Professional operating system</td>
<td>Pentium II® 300MHz or more (Pentium II® 450MHz or more recommended)</td>
<td>128MB or more (192MB or more recommended)</td>
</tr>
<tr>
<td>Microsoft® Windows® XP Home Edition operating system</td>
<td>Pentium® 400MHz or more (Pentium II® 500MHz or more recommended)</td>
<td>128MB or more (192MB or more recommended)</td>
</tr>
</tbody>
</table>
4. INSTALLATION AND UNINSTALLATION

This chapter explains the installation and uninstallation of the software programs stored in GT Works2/GT Designer2.

4.1 Starting the Menu Screen

1. Insert the CD-ROM into the CD drive of the PC where Windows® has started. The menu screen will soon start.

2. As the menu screen of GT Works2/GT Designer2 starts, install the corresponding software or view the PDF manual.

As this menu screen is displayed after completion of one process, another process can be executed without a break. When it is desired to end the menu screen, click the [Exit] button.

If the menu screen does not start

Start the menu screen in the following procedure if it does not start automatically when the CD-ROM of GT Works2/GT Designer2 is inserted into the CD drive.

(1) Using Device Manager of Windows®, make setting to start the CD drive automatically.

(2) Start Explorer and double-click the following files of the CD drive.

- Disc1: GTWK2-E1.exe, or GTD2-E1.exe
- Disc2: GTWK2-E2.exe, or GTD2-E2.exe
4.2 Installing the Software Programs

Point

Installation precautions

(1) Before installation, close all other applications running on Windows®.
(2) Before installing GT Designer2, do not connect the GOT to the PC.
(3) When using Windows NT® Workstation 4.0, Windows® 2000 Professional, Windows® XP, or Windows Vista®, log on as a user with administrative privileges (for computer management).
(4) During installation, do not install any other software.
(5) During installation, do not remove the CD-ROM from the CD drive.
(6) To install MELSOFT applications on a personal computer with Windows Vista®, read the technical bulletin FA-A-0008.
(7) During installation with the use of Windows Vista®, the following screens may be displayed.

When the screen on the right is displayed, select "This program installed correctly".
Do not select [Reinstall using recommended settings], because an incorrect module is installed.

When the screen on the right is displayed, select "Allow".

When the screen on the right is displayed, select "Install this driver software anyway".

4.2 Installing the Software Programs
Screens displayed midway during installation

To prepare for installation, any of the following screens may be displayed midway during installation. (The display changes depending on the Windows®.) If any of the following screens is displayed, reinstall the product after execution of the specified exe file according to the instruction of the screen. When the product has not been installed correctly, restart the computer once.

- If the screen on the right is displayed, execute \Update\50comupd.exe of the CD-ROM.
- If the screen on the right is displayed, execute \Update\AXDIST.exe of the CD-ROM.
- If the screen on the right is displayed, execute \EnvMEL\SETUP.exe of the CD-ROM.

When installing/viewing the data of Disc 2 from Disc 1 or that of Disc 1 from Disc 2

The same menu screen is displayed even if either Disc 1 or Disc 2 is inserted into the CD drive of the PC.

When the data to be installed/viewed is not stored in the CD-ROM in the CD driver, the following message is displayed. In the case, insert the CD-ROM displayed in the message window. (When the appropriate CD-ROM is inserted, the menu screen is displayed again.)

Example: When inserting Disc 1 into the CD drive to view manuals.
4.2.1 Software installing procedure

1 How to install GT Designer2

1 Insert Disc 1 into the CD drive of the PC.

2 Click the GT Designer 2 Installation to be installed.

3 The screen on the left is displayed. Click the Next button.

4 Input you name, your company name, the product ID of the product and click the Next button.

The product ID is indicated in the software registration form packed with the product.
4.2 Installing the Software Programs

4.2.1 Software installing procedure

5. Specify the installation destination folder.
   The installation destination folder defaults to "C:\Program Files\MELSEC".
   When the default is acceptable, click the Next> button.
   To change the default, click the Browse... button and specify a new drive and folder.

6. The screen on the left is displayed. Click the Next> button to start the installation.

7. When the screen on the left is displayed, click the Continue button.

8. When the installation is completed, the screen on the left is displayed. Click the Finish> button.
   When the restart screen is displayed, restart Windows®.
How to install GT SoftGOT2, GT SoftGOT1000, GT Simulator2, GT Converter2, MES DB Connection Service, Document Converter, and Data Transfer Tool

1. Insert Disc 1 into the CD drive of the PC.
2. Click the software to be installed.
3. When "GT SoftGOT Menu" has been selected, the screen on the left is displayed.

- "GT SoftGOT1000 Installation" GT SoftGOT1000 will be installed.
- "GT SoftGOT2 Installation" GT SoftGOT2 will be installed.
- "System Driver Installation" System Driver will be installed.

When the PC CPU module is used, System Driver does not need to be installed.
Observe the following points when installing System Driver.
- Before installing System Driver, do not mount the license key (USB port) to the PC.
- During System Driver installation, do not mount the license key (USB port) to the PC.

* Unless System Driver is installed, GT SoftGOT2 will not recognize the license key even if the license key is mounted to PC.
4.2 Installing the Software Programs

4.2.1 Software installing procedure

4 When "Tools" has been selected, the screen on the left is displayed.
   "MES DB Connection Service installation"
   MES DB Connection Service will be installed.
   "Document Converter Installation"
   Document Converter will be installed.
   "Data Transfer Tool Installation"
   Data Transfer Tool will be installed.
   "GT MMDataConnector Installation"
   GT MMDataConnector Tool will be installed.

5 Input your name and your company name, and click the [Next>] button.
   As the confirmation dialog box is displayed, perform operation according to the message.

6 When "MES DB Connection Service installation" has been selected, the screen on the left is displayed.
   Input the product ID of the product and click the [Next>] button.
   The product ID is indicated in the software registration form packed with the product.
4.2 Installing the Software Programs

4.2.1 Software installing procedure

Specify the installation destination folder.
The installation destination folder defaults to "C:\MELSEC".
When the default is acceptable, click the Next> button.
To change the default, click the Browse... button and specify a new drive and folder.

The installation starts.
When the installation is completed, the screen shown on the left is displayed. Click the OK button.
If the Restart screen is displayed, restart Windows®.

When GT Designer2, GT Simulator2 and GT SoftGOT2 are installed, icons are registered as shown below.
4.2.2 Installing the manual data

Install the online manual data that is viewed from Help of GT Designer2.

1. Insert Disc 2 into the CD drive of the PC.
2. Click the GT Manual menu.
4. Specify the installation destination folder.
   The installation destination folder defaults to "C:\Program Files\MANUAL".
   When the default is acceptable, click the [Next] button.
   When changing the installation destination, click the [Browse...] button and specify a new destination drive and folder.
The installation starts. When the installation is completed, the screen shown on the left is displayed. Click the OK button.

Adobe Reader must be installed separately to view the online manual.
4.3 Uninstalling the Software Programs

**Uninstallation precautions**

1. Before uninstallation, make sure to close all software packages.

2. When using Windows NT® Workstation 4.0, Windows® 2000 Professional, Windows® XP, or Windows Vista®, log on as a user with administrative privileges (for computer management).

3. During uninstallation with the use of Windows Vista®, the following screen may be displayed.

When the screen on the right is displayed, select "Continue".

### 4.3.1 Software uninstalling procedure

1. Click "Add or Remove Programs" in the Control Panel.

2. Select the software to be uninstalled.

   After selection, click the **Add/Delete** button.

(To next page)
4.3 Uninstalling the Software Programs

4.3.1 Software uninstalling procedure

1 Confirm the software to be deleted.
   - Click the Yes button to start uninstallation.
   - Click the No button to return to the previous screen without executing uninstallation.
   * Components indicate the installed icon and files.

2 When the screen as on the left (the file name and location display may be different) is displayed, click the No to All button.
   * When the Yes or Yes to All button is clicked, the shared file of MELSOFT may be deleted and the other software packages may not operate.

3 When uninstallation is completed, the screen on the left is displayed. Click the OK button.
4.4 Starting the Software

Point

When GT SoftGOT2 has been installed in the PC CPU module
When GT SoftGOT2 installed in the PC CPU module is used, a license must be
registered to the PC CPU module using the license key FD.
Refer to the following manual for the license key FD registration method.
GT SoftGOT2 Version1 Operating Manual

1 Click the menu of the software package to be
   started.
   • In the case of GT Designer2, GT SoftGOT2
     or GT Converter2
     Make selection from [Start] → [All Programs]
     [MELSOFT Application] [GT Works2].

2 The corresponding software package starts.

When GT SoftGOT2 has been installed in the PC CPU module
When GT SoftGOT2 installed in the PC CPU module is used, a license must be
registered to the PC CPU module using the license key FD.
Refer to the following manual for the license key FD registration method.
GT SoftGOT2 Version1 Operating Manual

Click the menu of the software package to be
started.
• In the case of GT Designer2, GT SoftGOT2
  or GT Converter2
  Make selection from [Start] → [All Programs]
  [MELSOFT Application] [GT Works2].

The corresponding software package starts.
5. HOW TO USE THE ONLINE MANUAL AND HELP

5.1 How to Use the Online Manual

The online manual is contained in the CD-ROM of the product in the form of PDF data. To view the PDF data, Acrobat Reader must have been installed in the PC. When Adobe® Reader® has not been installed in the PC, refer to the following and install Adobe® Reader®.

The online manual can be viewed in the following procedure.


2. As the INDEX MENU screen is displayed, click the manual to be viewed.

Click here when viewing from CD-ROM

Click here when viewing the manual installed.

(To next page)
3 The selected manual is displayed.

Clicking the index item switches the manual display screen. Click "INDEX_MENU" to return to the INDEX_MENU screen (manual selection screen).

**Remark**

The online manual can be viewed from the Start menu or GT Designer2 Help after installation of GT Manual.

Refer to the next page for how to view it from Help.

(GT series)
5.2 How to Use Help

Help displays the GT Designer2 relevant PDF manuals and the software version.

**Point** Before viewing the PDF manual
To view the PDF manual, GT Manual and Adobe® Reader® must be installed.

1 Operation method

1 Click the corresponding menu within [Help].

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>GOT1000 series</th>
<th>GOT900 series</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating Manual</td>
<td>Displays the GT Designer2 Version Operating Manual</td>
<td>—</td>
<td>○</td>
</tr>
<tr>
<td>Basic Operation/Data Transfer Manual</td>
<td>Displays the GT Designer2 Version Basic Operation/Data Transfer Manual</td>
<td>○</td>
<td>—</td>
</tr>
<tr>
<td>Screen Design Manual</td>
<td>Displays the first/second volume of the GT Designer2 Version Screen Design Manual</td>
<td>○</td>
<td>—</td>
</tr>
<tr>
<td>Index</td>
<td>Displays the PDF manual list.</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>About GTD2…</td>
<td>The GT Designer2 version can be confirmed.</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Connect to MELFANSweb…</td>
<td>Connects to the Mitsubishi Electric FA Equipment Technology Information Service MELFANSweb home page.</td>
<td>○</td>
<td>○</td>
</tr>
</tbody>
</table>

2 PDF manual viewing procedure
When the Basic Operation/Data Transfer Manual/Screen Design Manual is selected

1 The selected manual is displayed.
   (For details of the Adobe® Reader® operation method, refer to Help of Adobe® Reader®.)
   Clicking INDEX MENU displays the manual list (This section 3 1).

Switches the display to the page of the selected item.

Returns to INDEX MENU.
3 PDF manual viewing procedure (When [Index] is selected)

1 After performing operation in , the following screen appears. Click the manual to be viewed.

INDEX MENU GOT900 Series

- GOT-A900 Series / GOT-F900 Series PDF Manual
  - GT Designer 2 Version 2 Operating Manual

- GOT-A900 Series PDF Manual
  - GT Designer 2 Version 2 Operating Manual

- GOT-F900 Series PDF Manual

2 The selected manual is displayed.

(For details of the Adobe® Reader® operation method, refer to Help of Adobe® Reader®.)
5.3 How to View the Product Information

The product information can be viewed in the following procedure.


2. The screen (About GTD2) shown on the left appears.

![About GTD2 screen]

- Version 2.81K
- Minor version of GT Designer2
- Major version of GT Designer2
- Product model name: SW□D5C-GTD2-E
- Major version of GT Designer2
6. WHAT IS THE GOT?

6.1 About the GOT

1 What is the GOT?
The GOT (Graphic Operation Terminal Unit) can be used as an electronic operation panel on which functions such as switch operation, lamp display, data display, message display can be operated on the monitor screen, which had been conventionally implemented with a control box.

2 About monitor screen data to be displayed on GOT
Create the monitor screen data, which will be displayed on the GOT, using the dedicated software (GT Designer2) on the personal computer.
On GT Designer2, paste display frame figures called objects, such as switch figures, lamp figures and numerical display, to create a screen, and set operation functions to the pasted objects with the device memory (bit, word) of the PLC CPU to execute the functions of the GOT.
Transfer the created monitor screen data to the GOT via an RS-232 cable or memory card.
6.2 About GOT Operation

This section explains briefly what operation the GOT will perform when it is connected with the PLC CPU.

1 System example

While the touch switch "Operation" of the GOT is being touched, the bit device "M0" is ON.

When the bit device "M0" turns ON, the bit device "Y10" turns ON.

An ON figure is also displayed in the lamp of the GOT where the monitor device has been set to the bit device "Y10".

(To next page)
3 As the bit device "M0" is ON, "123" is stored into the word device "D10".

Also, "123" is displayed in the numerical display of the GOT where the monitor device has been set to the bit device "D10".

4 While the touch switch "Stop" of the GOT is being touched, the bit device "M1" of the PLC CPU is ON.

Since the OFF condition of the bit device "Y10" of the PLC CPU is met, the lamp of the GOT turns OFF.
7. CREATING THE MONITOR DATA

This and latter chapters explain how to create screens on GT Designer2 and operate them on the GOT. For those who will use the GOT for the first time or who want to know the specific operation examples of GT Designer2, it is recommended to refer to this and latter chapters and use the GOT and GT Designer2.

7.1 Creating Screens

After making preparations for screen creation, create screens actually. In this manual, the following two screens will be created.

<table>
<thead>
<tr>
<th>Base screen 1</th>
<th>Base screen 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Numerical Display</strong></td>
<td><strong>Numerical Input</strong></td>
</tr>
<tr>
<td><img src="image" alt="Numerical Display" /></td>
<td><img src="image" alt="Numerical Input" /></td>
</tr>
<tr>
<td><strong>Alarm Limb</strong></td>
<td><strong>Alarm Reset Switch</strong></td>
</tr>
<tr>
<td><img src="image" alt="Alarm Limb" /></td>
<td><img src="image" alt="Alarm Reset Switch" /></td>
</tr>
<tr>
<td><strong>System Alarm</strong></td>
<td><strong>Error Screen</strong></td>
</tr>
<tr>
<td><img src="image" alt="System Alarm" /></td>
<td><img src="image" alt="Error Screen" /></td>
</tr>
</tbody>
</table>

*Error Screen:*

A-line supply conveyor stopped. Check the power source.
7.1.1 Screen configuration of GT Designer2

Before creating screens, the basic screen configuration of GT Designer2 will be explained.

Menu bar

Toolbar

Workspace
The settings of the whole project, such as the created screens and common settings, are displayed in a tree form. Setting, copy, etc. can be performed by double-click and right-click.

Property sheet
The selected screen/object/figure attributes are displayed. Setting can be also made here.

Data View
All object functions, object number and figures set on the drawing are displayed in a list.

Status bar
7.2 Setting before Screen Creation

Before creating a screen, set the GOT to be used, the type of the PLC CPU, and the title of the screen.

7.2.1 Creating a project

First, create a new project.

Example)

1. Starting GT Designer2 displays the screen on the left.
   As a new screen will be created this time, click the New button.

2. The screen on the left (Start New Project Wizard) is displayed, so click the Next button.
   * If the “Show Wizard on New Project” box is unchecked, the wizard will not appear the next time a new project is created.

3. The screen on the left (System Settings for GOT) is displayed, so select the GOT type to be used and color setting. After the selection is made, click the Next button.

   Settings
   GOT Type: A97*GOT/GT SoftGOT(640 × 480)
   Color Settings: 256 color

4. The screen on the left (Confirmation of System Settings for GOT) is displayed, so click the Next button after confirming the settings.
The screen on the left (Communication Settings (1st)) is displayed, so select the equipment that is connected to GOT. After the selection is made, click the **Next** button.

**Settings**
Controller: MELSEC-QnA/Q, MELDAS C6*

The screen on the left (Setting of Screen Switch Device) is displayed, set the Switch Device for the Base Screen. After the specification is made, click the **Next** button.

**Settings**
Base Screen
Screen Switch Device: GD100

The screen on the left (Set Confirmation of System Environment) is displayed, so click the **Finish** button after confirming the settings.
7.2 Setting before Screen Creation

7.2.1 Creating a project

Perform the following settings.

1. Select the [Project] ➔ [Preferences...] operation tab.

2. Uncheck "Show Wizard on New Project" box on the Operation tab in the Preferences dialog box.

3. Click the close button.

To restart the wizard, display the Operation tab in the Preferences dialog box again and check "Show Wizard on New Project" box.

8. The Screen Property dialog box is displayed, so enter the screen name.

9. When the OK button is clicked, base screen 1 is created.

Settings
Screen Name: Data display screen

Point

(1) Creating a new project without starting the wizard
Perform the following settings.

1. Select the [Project] ➔ [Preferences...] operation tab.

2. Uncheck "Show Wizard on New Project" box on the Operation tab in the Preferences dialog box.

3. Click the close button.

To restart the wizard, display the Operation tab in the Preferences dialog box again and check "Show Wizard on New Project" box.
7.2.2  Creating the second screen

One screen has already been created in the previous section (Section 7.2.1 Setting before Screen Creation). Since two screens will be created in this manual, create the second screen first.

[Diagram: Creating the second screen]

1. Right-click on the Base Screen on the tree in the project workspace and select [New].

2. As the Screen Property dialog box is displayed, input the screen name.

3. Click the OK button to create the second screen.

Set data
Screen Name: Error screen

7.2.3  Setting the screen switching device

1. What is screen switching device?
A screen switching device is a word device used to switch the screen on the GOT. The GOT switches to the screen of the numeric value stored in the screen switching device. Use the screen switching device for screen switching only.

When the value of the screen switching device is 1, the GOT displays Base Screen 1.

When the value of the screen switching device turns from 1 to 2, the GOT displays Base Screen 2.
7.2.4 How to switch between the created screens

One created screen can be switched to the other by double-clicking either of the base screens on the tree in the project workspace.


2. As the System Environment dialog box is displayed, double-click [Screen Switching].

3. As the Screen Switching Device Settings dialog box is displayed, set [Base Screen Switching].
   - Set data
   - Base Screen Switching: D100

4. Clicking the **OK** button completes the setting of the screen switching device.
7.3 Drawing Figures and Inputting Texts

First, draw frame lines and input texts to create the following screens. The methods are described below.

Base screen 1

Base screen 2

1. Frame line drawing method

1. Click .

2. As the mouse cursor turns into +, press the left mouse button at the starting point for drawing a rectangular.

3. Drag and move the cursor to the end point.

4. Release the left mouse button to draw a rectangular.
   (After arrangement, right-click the mouse to cancel the arrangement mode.)

5. As double-clicking the created rectangle displays the Setting dialog box, the color and thickness of the line can be changed.

6. Click the OK button to close the dialog box.

7. Repeat steps 1 to 6 to draw frame lines. After selecting the drawn figure, holding down the Ctrl key and dragging the figure allows it to be copied easily.
## Text input method

1. Click **A**.

2. As the mouse cursor turns into +, click the mouse in the position where a text will be entered.
   (After arrangement, right-click the mouse to cancel the arrangement mode.)

3. As clicking the mouse displays the Text dialog box, input a text.
   The input result is immediately reflected on the screen.

4. Click the **OK** button to close the dialog box.

---

### Figure and text size changing method

After selecting the figure or text to be resized, drag the handle ( ) to change the size.

**Example:** When resizing a rectangle

---

<table>
<thead>
<tr>
<th>Text Style</th>
<th>Direction</th>
<th>Text Color</th>
<th>Font Size</th>
<th>Text Color</th>
<th>Font Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Regular</td>
<td>Horizontal</td>
<td>Must</td>
<td>15</td>
<td>Must</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td>Vertical</td>
<td>Must</td>
<td>15</td>
<td>Must</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Must</td>
<td>15</td>
<td>Must</td>
<td>15</td>
</tr>
</tbody>
</table>

---

**Hints:**

- **Text:** Numerical Display
- **Text Style:** Regular
- **Text Color:** Must
- **Font Size:** 15
7.4 Setting the Object Function

After drawing figures and texts, set their object functions. This section explains the object function to be set in this manual.

Numerical Display
The value stored in the PLC CPU device is displayed. (Section 7.4.1)

Lamp (Bit Lamp)
The lamp is lit when the bit device of the PLC CPU turns ON. (Section 7.4.2)

Alarm List
(System Alarm)
The error that occurred in the GOT is displayed. (Section 7.4.5)

Numerical Input
The value is written to the PLC CPU device. (Section 7.4.1)

Switch
(Bit switch)
Touching this switch turns OFF the bit device of the PLC CPU. (Section 7.4.3)

Switch
(GO TO Screen Switch)
Touching this switch switches the screen. (Section 7.4.4)

Alarm list display
(User Alarm)
When the bit device turns ON, the corresponding comment preregistered by the user is displayed. (Section 7.4.6)

Switch
(GO TO Screen Switch)
Touching this switch switches the screen. (Section 7.4.4)
7.4.1 Numerical Display/Numerical Input setting method

1. Click \( \text{\(\text{\(\text{(Numerical Display)}\)}} \) or \( \text{\(\text{\(\text{(Numerical Input)}\)}} \).
2. As the mouse cursor turns into +, click the mouse in the desired position to arrange the display or input.
   (After arrangement, right-click the mouse to cancel the arrangement mode.)
3. As double-clicking the arranged numerical display or numerical input displays the dialog box, make settings. (See below.)

   **Set data (Numerical Display)**
   - **Type**: Numerical Display
   - **Device**: D10
   - **Shape**: Frame_1

   **Set data (Numerical Input)**
   - **Type**: Numerical Input
   - **Device**: D11
   - **Shape**: Frame_1

4. After the setting is complete, click the **OK** button.

(To next page)
5 Change the size.

6 When the object is resized, the figure frame and object may be displaced. If the figure frame and object are displaced, select the object, then right-click the mouse, and select [Centering]. The displacement is automatically corrected.

When [Edit Touch Area/Frame Region] is selected, the figure frame and object can be moved individually by the user.

7 This completes the numerical display/numerical input setting.

Objects set in this section

Base screen 1

Numerical Display

Base screen 2

Numerical Input

Alarm Lamp

Alarm Reset Switch

System Alarm
7.4.2 Lamp setting method

1. Click the symbol.

2. As the mouse cursor turns into +, click the mouse in the desired position to arrange the lamp. (After arrangement, right-click the mouse to cancel the arrangement mode.)

3. As double-clicking the arranged lamp displays the dialog box, make settings. (See below.)

   - **Set data Basic tab**
     - Device: M0

   - **Set data Text tab**
     - Text: M0

4. After setting the character tab, click the **All Settings** button at **Copy OFF → ON** button. (The Text tab data set at OFF is reflected at ON.)
   - Click the **ON** button to confirm the ON-time attributes.
   - Register a text for each display position (Center, Top, Bottom, Left, Right).
   - The display position button turns red-purple (magenta) when the corresponding text is entered.

5. After the setting is complete, click the **OK** button.

6. This completes the setting of the first lamp.

(To next page)
7 When creating the second lamp or later, select the set lamp and then select the [Edit] → [Consecutive Copy...] / [Context menu] → [Consecutive Copy...] menu to display the Consecutive Copy dialog box.

Set data
Number X: 4
Interval X: 16

8 Click the OK button to copy the lamp.

9 Change the text of each lamp in the Property sheet.

10 This completes the lamp setting.

Objects set in this section
7.4.3 Touch Switch (Bit Switch) setting method

1. Click \( \text{□} \) to select \( \text{□} \) (Bit Switch) in the sub menu.

2. As the mouse cursor turns into +, click the mouse in the desired position to arrange the touch switch. (After arrangement, right-click the mouse to cancel the arrangement mode.)

3. As double-clicking the arranged touch switch displays the dialog box, make settings. (See below.)

   Set data Basic tab
   Device : M0
   Action : Reset
   Shape : rect_5

   Set data Text/Lamp tab
   Text : M0

4. After setting, click the All Settings button at Copy OFF – ON, button on the Text tab. (The Text tab data set at OFF is reflected at ON.) Click the ON button to confirm the ON-time attributes.

   Register a text for each display position (Center, Top, Bottom, Left, Right).
   The display position button turns red-purple (magenta) when the corresponding text is entered.

5. After the setting is complete, click the OK button.
This completes the setting of the first touch switch.

When creating the second touch switch or later, select the touch switch and then select the [Edit] → [Consecutive Copy...] / [Context menu] → [Consecutive Copy...] menu to display the Consecutive Copy dialog box.

Set data
Number X: 4
Interval X: 16

Click the OK button to copy the touch switch.

Change the text of each touch switch in the Property sheet.

This completes the touch switch setting.
7.4 Setting the Object Function

7.4.3 Touch Switch (Bit Switch) setting method

Objects set in this section

Base screen 1

Base screen 2
7.4.4 Touch Switch (GO TO Screen Switch) setting method

1. Click to select (GO TO Screen Switch) in the sub menu.

2. As the mouse cursor turns into +, click the mouse in the desired position to arrange the touch switch. (After arrangement, right-click the mouse to cancel the arrangement mode.)

3. As double-clicking the arranged touch switch displays the dialog box, make settings. (See below.)

   **Set data Basic tab**
   - GO TO screen: Fixed Screen (2)
   - Shape: rect_5

   **Set data Text/Lamp tab**
   - Text: Error
   - Screen

4. After setting, click the [All Settings] button at [Copy OFF → ON] button on the Text tab. (The Text tab data set at OFF is reflected at ON.)
   - Click the [ON] button to confirm the ON-time attributes.
   - Register a text for each display position (Center, Top, Bottom, Left, Right).
   - The display position button turns red-purple (magenta) when the corresponding text is entered.

5. After the setting is complete, click the [OK] button.
6. This completes the setting of the touch switch on Base screen 1. After setting, press the Ctrl key + C key with the touch switch selected. (Shortcut: Copy)

7. Double-click Base Screen 2 (Error screen) on the tree in the Project workspace to display Base screen 2.

8. Press the Ctrl key + V key on Base screen 2 to paste the copied touch switch. (Shortcut: Paste) Click the mouse to paste the touch switch.

9. Select the pasted switch, and change the set data in the Property sheet.

**Set data**
- **Fixed value**: 2 → 1
- **Text**: Error Screen → Data display Screen

---

**Overview**

**Software Package**

**System Configuration**

**Installation and Uninstallation**

**How to Use the Online Manual and Help**

**What is the GOT?**

**Creating the Monitor Data**

**Executing Monitor on the GOT**

---

7.4 Setting the Object Function

7.4.4 Touch Switch (GO TO Screen Switch) setting method
7.4.5 Alarm List (System Alarm) setting method

1. Click .

2. As the mouse cursor turns into +, click the mouse in the desired position to arrange the alarm list. (After arrangement, right-click the mouse to cancel the arrangement mode.)

3. Adjust the size.

4. This completes the setting of the alarm list (system alarm).

Object set in this section
7.4.6 Alarm List (User Alarm) setting method

To use the Alarm List (User Alarm), the comments to be displayed as alarms must be registered beforehand.

1 Comment registering method
In this manual, the following comments will be registered.

<table>
<thead>
<tr>
<th>Comment No</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A-line supply conveyer stopped. Check the power source.</td>
</tr>
<tr>
<td>2</td>
<td>Emergency stop limit switch operated. Check the product.</td>
</tr>
<tr>
<td>3</td>
<td>Product limit switch does not operate. Check for presence/absence of the product.</td>
</tr>
<tr>
<td>4</td>
<td>Hydraulic pressure of finishing machine 1 is low. Supply hydraulic oil.</td>
</tr>
</tbody>
</table>

1 Double-click [Comment] on the tree in the project workspace.
2 As the dialog box is displayed, register a comment.
3 After registering the comment, click (New Comment).
4 Register the second comment. After that, register the third and fourth comments in the same procedure.

5 When comment creation is completed, click the **Close** button.

2 Alarm List (User Alarm) setting method

1 Click .

2 As the mouse cursor turns into +, click the mouse in the desired position to arrange the alarm list.
   (After arrangement, right-click the mouse to cancel the arrangement mode.)
As double-clicking the arranged alarm list displays the dialog box, make settings. (See below.)

**Set data Basic tab**
- Alarm (Device) Points: 4

**Set data Device tab**
- Device No.: Continuous
- Alarm Device: M0

After setting is complete, click the **OK** button.

Adjust the size.

This completes the setting of the alarm list (user alarm).
7.5 Saving the Created Monitor Data

How to save the created monitor data is explained in this section.

1. Select the [Project] → [Save As].

2. As the dialog box is displayed, select the storage location and set the file name.

3. Click the Save button to save the monitor data.
7.6 Previewing the created project data

This section explains how to confirm the screen to be displayed on the GOT. Refer to the following for details.


2. The screen to be displayed on the GOT appears in the Screen Preview window.
8. EXECUTING MONITOR ON THE GOT

This chapter explains how to transfer the monitor data, which was created on GT Designer2, to the GOT and display them. This manual uses the A975GOT in the example for explanation. When applying the following program examples to the actual system, make sure to examine the applicability and confirm that it will not cause system control problems.

8.1 Transferring Monitor Data from Personal Computer to GOT

This section explains how to transfer the monitor screen data from the personal computer to the GOT.

8.1.1 Connecting the personal computer and GOT

Connect the personal computer and GOT.

*Hint* To shorten data transfer time

A memory card can also be used to transfer the monitor data. When the memory card is used, work time can be shortened since the data transfer speed is higher than RS-232 communication speed. *1

Refer to the following manual for data transfer using the memory card.

GT Designer2 Version2 Operating Manual

*1 Reference value ••• In the case of screen data (589,572 bytes (30 screens)), memory card: approx. 55 seconds, RS-232 communication: approx. 5 minutes
8.1.2 Installing the Standard monitor OS and Communication driver

The GOT does not include the Standard monitor OS for monitoring and the driver for communication with the PLC CPU. Hence, this installation operation must be performed only once before starting monitoring. This operation is required again when the OS is updated or the method of communication with the PLC is changed.

**Point**

Precautions for installation of OS

Installing the OS into the GOT erases the monitor data in the GOT. When the data in the GOT is necessary, upload them. (Section 8.3 Uploading)

1. Select the [Communication] → [To/From GOT].

2. As the dialog box is displayed, select the Communication Configuration tab.

3. On the Communication Configuration tab, confirm and set the communication setting of the used personal computer. After setting, select the OS install -> GOT tab.
8.1.3 Downloading the monitor data

After OS installation, download the created monitor data to the GOT.

1. Select the Download -> GOT tab.
2. On the Download -> GOT tab, select the data (base screen, window screen, common settings) to be downloaded to the GOT.
   - Project configuration tree: Check all.

After making selection, click the Download button to start the downloading of the monitor data.
8.2 Connecting with the PLC CPU

After transferring the Standard monitor OS, communication driver and monitor screen data to the GOT, connect the GOT and PLC CPU. This manual explains this connection in an example of bus-connecting the A975GOT and QCPU.

System configuration example

![Diagram of system configuration example]

*1 For the system configuration, usage, etc. of GX Developer, refer to the GX Developer Operating Manual.

**Point**

Precautions for bus connection

Refer to the following manual for the precautions for bus connection.


1 Connecting the communication board to the GOT

Mount the bus connection board to the communication board slot of the GOT. Mount the bus connection board with the GOT powered OFF.

Refer to the following manual for the communication board mounting method.

A985GOT/A975GOT/A970GOT/A960GOT User's Manual

![Diagram of connecting communication board to GOT]
2 Setting the extension stage number and I/O slot No. of the GOT
When bus connection is made, the extension stage number and I/O slot No. of the GOT must be set in [Setup] of the GOT utility.
For details of the utility, refer to the following manual.
GOT-A900 Series Operating Manual (Extended•Option Functions Manual)

Select "Setup" of utility.

In this example, set the QBUS extension stage number to "1".

3 Connecting to the PLC CPU
Connect the GOT and PLC CPU with the bus connection cable.
Before connecting the GOT to the PLC CPU, always power off the whole system.
Refer to the following manual for details of the system configuration for connection.
GOT-A900 Series Operating Manual (Connection System Manual)

In this example, connect to the main base.
Sequence program used in this section

```
SWT001

0: K10 20
   [MOV] K1 20
   [MOV] K35 10
   [MOV] K35 11
   [MOV] K52 10
   [MOV] K24 10
   [MOV] K57 11
   [MOV] K12 10
   [MOV] K43 11
   [MOV] K43 11
   [MOV] K42 10
   [MOV] K74 11
   [MOV] K53 10
   [MOV] K85 11
   [MOV] K82 10
   [MOV] K12 10
   [MOV] K73 10
   [MOV] K35 11

55: END
```

8.2 Connecting with the PLC CPU
5 Operation image on GOT

Base screen 1

- The D10 value is displayed.
- When any of M0 to M3 is turned ON with GX Developer, etc., the corresponding lamp is lit.
- If an error occurs in the GOT or CPU, the error code and error message are displayed.
- Touching here displays the key window and inputs the value to D11.
- Touching the switch turns OFF the corresponding one of M0 to M3 that is ON (extinguishes the lamp).
- Touching here switches the display to Base screen 2.

Base screen 2

- Comments of M0 to M3 that are ON on Base screen 1 are displayed.
- Touching here switches the display to Base screen 1.
8.3 Uploading

When it is desired to back up or correct the monitor data that has been downloaded to the GOT, upload the monitor data to the personal computer.

1. Select the [Communication] → [To/From GOT].

2. As the dialog box is displayed, select the Upload -> Computer tab.
   - Upload path: GT Designer2

3. Click the [Upload] button to execute uploading.
MEMO
WARRANTY

Please confirm the following product warranty details before using this product.

1. Gratis Warranty Term and Gratis Warranty Range

If any faults or defects (hereinafter "Failure") found to be the responsibility of Mitsubishi occurs during use of the product within the gratis warranty term, the product shall be repaired at no cost via the sales representative or Mitsubishi Service Company. However, if repairs are required onsite at domestic or overseas location, expenses to send an engineer will be solely at the customer’s discretion. Mitsubishi shall not be held responsible for any re-commissioning, maintenance, or testing on-site that involves replacement of the failed module.

[Gratis Warranty Term]
The gratis warranty term of the product shall be for one year after the date of purchase or delivery to a designated place. Note that after manufacture and shipment from Mitsubishi, the maximum distribution period shall be six (6) months, and the longest gratis warranty term after manufacturing shall be eighteen (18) months. The gratis warranty term of repair parts shall not exceed the gratis warranty term before repairs.

[Gratis Warranty Range]
(1) The range shall be limited to normal use within the usage state, usage methods and usage environment, etc., which follow the conditions and precautions, etc., given in the instruction manual, user's manual and caution labels on the product.
(2) Even within the gratis warranty term, repairs shall be charged for in the following cases.
   1. Failure occurring from inappropriate storage or handling, carelessness or negligence by the user. Failure caused by the user's hardware or software design.
   2. Failure caused by unapproved modifications, etc., to the product by the user.
   3. When the Mitsubishi product is assembled into a user's device, Failure that could have been avoided if functions or structures, judged as necessary in the legal safety measures the user's device is subject to or as necessary by industry standards, had been provided.
   4. Failure that could have been avoided if consumable parts (battery, backlight, fuse, etc.) designated in the instruction manual had been correctly serviced or replaced.
   5. Failure caused by external irresistible forces such as fires or abnormal voltages, and Failure caused by force majeure such as earthquakes, lightning, wind and water damage.
   6. Failure caused by reasons unpredictable by scientific technology standards at time of shipment from Mitsubishi.
   7. Any other failure found not to be the responsibility of Mitsubishi or that admitted not to be so by the user.

2. Onerous repair term after discontinuation of production

(1) Mitsubishi shall accept onerous product repairs for seven (7) years after production of the product is discontinued. Discontinuation of production shall be notified with Mitsubishi Technical Bulletins, etc.
(2) Product supply (including repair parts) is not available after production is discontinued.

3. Overseas service

Overseas, repairs shall be accepted by Mitsubishi's local overseas FA Center. Note that the repair conditions at each FA Center may differ.

4. Exclusion of loss in opportunity and secondary loss from warranty liability

Regardless of the gratis warranty term, Mitsubishi shall not be liable for compensation of damages caused by any cause found not to be the responsibility of Mitsubishi, loss in opportunity, lost profits incurred to the user by Failures of Mitsubishi products, special damages and secondary damages whether foreseeable or not, compensation for accidents, and compensation for damages to products other than Mitsubishi products, replacement by the user, maintenance of on-site equipment, start-up test run and other tasks.

5. Changes in product specifications

The specifications given in the catalogs, manuals or technical documents are subject to change without prior notice.

6. Product application

(1) In using the Mitsubishi MELSEC programmable logic controller, the usage conditions shall be that the application will not lead to a major accident even if any problem or fault should occur in the programmable logic controller device, and that backup and fail-safe functions are systematically provided outside of the device for any problem or fault.
(2) The Mitsubishi programmable logic controller has been designed and manufactured for applications in general industries, etc. Thus, applications in which the public could be affected such as in nuclear power plants and other power plants operated by respective power companies, and applications in which a special quality assurance system is required, such as for Railway companies or Public service purposes shall be excluded from the programmable logic controller applications. In addition, applications in which human life or property that could be greatly affected, such as in aircraft, medical applications, incineration and fuel devices, manned transportation, equipment for recreation and amusement, and safety devices, shall also be excluded from the programmable logic controller range of applications. However, in certain cases, some applications may be possible, providing the user consults their local Mitsubishi representative outlining the special requirements of the project, and providing that all parties concerned agree to the special circumstances, solely at the users discretion.